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RESUMEN 

Esta investigación se realizó en dos parcelas del bosque estacionalmente seco del Huallaga de 

0,52 ha dividida en 13 sub-cuadrantes de 20 x 20 m cada una, situadas en la región San Martin una 

en San Pedro de Cumbaza y otra en Pucacaca.  El objetivo fue evaluar la estructura poblacional de 

Attalea moorei en dos parcelas del Bosque estacionalmente seco del Huallaga. Para la estructura 

poblacional se consideró categorías de crecimiento I, II, III, IV. En San Pedro de Cumbaza se 

registraron 1550 individuos, donde de Categoria I fueron 1219, Categoria II 271, Categoria III 27 

y Categoria IV 32. Asimismo, para Pucacaca se registraron 1220 donde en Categoria I fueron 900, 

Categoria II 218, Categoria III 52 y Categoria IV 50, de las cuales se realizó análisis de proporción 

de estadios fenológicos y localidad con p-valor de 0.05 donde la variable proporción de estadios 

fenológicos es diferente en cada localidad, asimismo se procedió a realizar otras evaluaciones 

presentando diferencias significativas en comparación promedio de categorías con la variable 

altura (cm). La distribución potencial de Attalea moorei presenta que las dos provincias de la 

región San Martin tienen la mayor probabilidad de distribución de la especie abarcando desde 10% 

(bajo), 37% (medio) y 94 % (alto).. Para la caracterizacion del suelo en las dos localidades 

consistió en describir las características físicas (textura, color), comparando los colores con la tabla 

munsell y presentando diferencias en su composición en San Pedro de Cumbaza y Pucacaca.  Los 

resultados señalan que existe diferencia significativa entre los promedios de alturas de las 

categorías de crecimiento de Attalea moorei entre las dos localidades. 

 

 

Palabras claves: Estadios fenológicos, distribución potencial, estructura poblacional. 
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ABSTRAT 

This research was carried out in two plots of the seasonally dry forest of the Huallaga of 0.52 

ha divided into 13 sub-quadrants of 20 x 20 m each, located in the San Martin region, one in San 

Pedro de Cumbaza and the other in Pucacaca. The objective was to evaluate the population 

structure of Attalea moorei in two plots of the seasonally dry Huallaga Forest. For the population 

structure, growth categories I, II, III, IV were considered. In San Pedro de Cumbaza, 1,550 

individuals were registered, where there were 1,219 in Category I, Category II 271, Category III 

27 and Category IV 32. Likewise, for Pucacaca, 1,220 were registered where in Category I there 

were 900, Category II 218, Category III 52 and Category IV 50, of which an analysis of the 

proportion of phenological stages and locality was carried out with a p-value of 0.05 where the 

variable proportion of phenological stages is different in each locality, likewise other evaluations 

were carried out showing significant differences in average comparison of categories with the 

variable height (cm). The potential distribution of Attalea moorei shows that the two provinces of 

the San Martin region have the highest probability of distribution of the species, ranging from 10% 

(low), 37% (medium) and 94% (high). For the characterization of the soil in the two localities, it 

consisted of describing the physical characteristics (texture, color), comparing the colors with the 

Munsell table and presenting differences in their composition in San Pedro de Cumbaza and 

Pucacaca. The results indicate that there is a significant difference between the average height of 

the Attalea moorei growth categories between the two localities. 

 

 

Keywords: phenological stages, potential distribution, population structure. 
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CAPÍTULO I. 

INTRODUCCION 

1.1.  Identificación del problema  

El estudio a nivel poblacional es un método que ha proporcionado información sobre el 

comportamiento de los sistemas ecológicos, al descubrir que especies son las más susceptibles 

a los cambios del entorno orientado a la conservación de especies (Sanchez, Zamorano, Peters, 

& Moya, 2009). 

El medio ambiente sostiene la vida humana, mediante el  cual los ecosistemas nos proveen 

del aire que respiramos, el agua que tomamos, los alimentos que nos nutren y de las experiencias 

estéticas que inspiran a nuestras culturas y llenan nuestras vidas (Aylor, Ominguez, Uñoz, Aura, 

& Offman, 2007) . Los recursos forestales no maderables han sido considerados como una 

alternativa de conservación de América latina y regiones tropicales a nivel mundial, ya que esta 

actividad es una opción sostenible a través del tiempo. Los bosques tropicales han sufrido 

fuertes amenazas comerciales tolerando un costo ecológico difícil de cuantificar (Shaanker, 

Ganeshaiah, Rao, & Aravind, 2004). 

Existen disputas acerca de las bondades y desventajas de la extracción de los recursos 

naturales. Por un lado, se establecieron costos ambientales directos, como la decadencia de la 

abundancia del recurso, cambios en la demografía y la dinámica poblacional o también la 

variación de precipitación a nivel local. Sin embargo, existen los costos indirectos como 

desbalances en la cadena alimenticia y varios ciclos ecológicos (Olmsted, 1995). 

A nivel de comunidades humanas podemos relacionar varios conflictos como la pérdida del 

conocimiento etnobotánico, la desigualdad en la cadena de valor de los productos generados, la 

falta de incentivos y capacitación para que mediante esto los agricultores o propietarios de las 

tierras practiquen un manejo adecuado de los recursos (Shaanker et al., 2004). Por otro lado, la 
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idea de la extracción de recursos al ser aplicado adecuadamente podría llegar a ser una 

alternativa de protección de bosques naturales, promoviendo el cultivo de plantas nativas  

volviendo a los bosques en sistemas agroforestales, mediante esto las especies se protegen en 

un estado seminatural, sin recurrir a la tala de árboles, incrementando la diversidad de plantas 

nativas y aparición de nuevas especies (Pedersen & Skov, 2001). 

Las palmeras forman uno de los grupos vegetales de mayor utilidad para poblaciones locales, 

ya que principalmente se encuentran en regiones tropicales, pero en nuestro país la extracción 

de este recurso es limitado, ya que, con un adecuado manejo, éste podría generar mayores 

fuentes de ingresos económicos (Kvist, 2006).  

La amazonia occidental agrupa la más alta biodiversidad de la cuenca amazónica, mediante 

el cual los estudios en distribución y ecología de las especies son escasos, es por esto que los 

recursos biológicos de la zona se encuentran insuficientemente caracterizados y valorados. Las 

palmeras son un grupo de plantas de gran importancia por la abundancia que existe, al mismo 

tiempo por el uso que le asignan los pobladores de la región.  

Cerca de dos tercios de las casi 200 especies de palmeras amazónicas están presentes donde 

muchas de ellas se encuentran restringidas en la amazonia, ya que tienen una taxonomía 

indefinida sobre su distribución.  

La información del género Attalea respecto a su biología y ecología es limitada, aunque se 

registran estudios en otros campos de la ciencia con respecto al género en mención. La 

identificación de estas especies es poco entendida debido a la escasez de colecciones en 

herbarios. 

Existe una especie ampliamente distribuida en la región San Martin y en otras regiones 

aledañas, de la cual se reportan diversos usos y aprovechamientos, siendo conocida como 
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“Shapaja” (Attalea moorei). Esta especie es el principal eje de estudio del presente proyecto de 

investigación, debido a la necesidad de realizar una detallada evaluación para llenar los 

existentes espacios vacíos de información, evidenciando un valor socioeconómico asociado a 

la especie en mención. 

 ¿Qué diferencias existe entre las dos parcelas del bosque estacionalmente seco del 

Huallaga y la estructura poblacional de Attalea moorei (Shapaja) - San Martin 2019?  
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1.2.  Objetivos de la investigación  

1.2.1.  Objetivo general  

Determinar la estructura poblacional de Attalea moorei (Shapaja) en dos parcelas del 

bosque estacionalmente seco del Huallaga. 

1.2.2.  Objetivo especifico 

  Evaluar la estructura poblacional de Attalea moorei (Shapaja) en las dos parcelas del  

bosque estacionalmente seco del Huallaga. 

   Obtener un modelo para predecir la distribucion de Attalea moorei en las dos 

parcelas del bosque estacionalmentre seco del Huallaga.  

   Caracterizar el tipo de suelo de las dos parcelas del bosque estacionalmente seco del 

Huallaga. 

1.3.  Justificación 

 En la amazonia existen diversas especies forestales y productos que pueden aprovecharse 

de forma distinta. Muchas de las especies nativas de la amazonia son utilizadas por las 

comunidades locales ya sea por sus hojas, frutos, etc.; en la actualidad se conocen muchas 

especies de palmeras que benefician a las comunidades en las regiones de Ucayali, San Martin, 

Loreto y Madre de Dios. Algunas de las palmeras que destacan por su uso: el aguje (empleado 

en la alimentación, artesanía), irapay (usado para la construcción), chambira (aprovechado para 

la artesanía), shebon (aplicado en la industria de la medicina y cosmética), shapaja (empleado 

en la medicina tradicional y construcción) entre otros (Zamora, 2010). 

A pesar del progreso constante de la taxonomía de las palmas de América del Sur durante 

las últimas dos décadas, el género Attalea sigue siendo incompleta entendido (Henderson, 1995) 

(Pintaud, 2008) (Noblick, Hahn, & M.P, 2013). 
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Las palmeras son el grupo de plantas más importantes en los bosques amazónicos, donde su 

importancia radica en su composición, estructura, etc. manteniendo así el equilibrio ecológico. 

En los ecosistemas, siendo entidades muy complejas, una posible aproximación a su resiliencia 

consiste en estudiar uno de sus componentes claves. Las poblaciones de palmeras son 

componentes particularmente importantes en numerosos ecosistemas neotropicales, incluyendo 

bosques húmedos, sabanas temporalmente inundadas y otros ambientes (Andrew Henderson & 

Tomlinson, 1991). La abundancia de las palmeras, su importancia en cuanto a biomasa, ciclo 

de nutrientes, interacciones con depredadores, dispersores y polinizadores determinan el papel 

clave de estas plantas en numerosos ecosistemas (Kahn & Moussa, 1994). Las palmeras tienen 

adicionalmente usos múltiples que les convierten en un recurso de mayor importancia en 

términos de servicios brindados por ecosistemas (Macía, 2004).  

El género Attalea (Arecaceae) se distribuye en hábitats continentales de la región 

Neotropical y en algunas islas del Caribe. Las formas de vida de las especies de Attalea varían 

de pequeñas palmeras acaulescentes de altas palmeras y masivas, siempre solitario. El rango 

ecológico del género abarca la mayor parte de los ecosistemas neotropicales, desde las dunas 

costeras de los bosques sub-andinos de hasta 1.600 m de altitud, tierras bajas húmedas a secas 

bosques, sabanas, pantanos, etc. 

Por estas razones, el presente estudio, pretende analizar con precisión las respuestas de las 

poblaciones de palmeras de la especie Attalea moorei con el fin de estudiar la estructura 

poblacional en dos parcelas ya que las perturbaciones pueden afectar a las poblaciones de 

palmeras y a los ecosistemas en los cuales se desarrollan numerosas, incluyendo la cosecha, la 

extracción maderera, la caza, los incendios de vegetación, la deforestación, etc.  (Brum, 2008). 

Los parámetros comúnmente usados incluyen el crecimiento, la biomasa, el éxito reproductivo, 
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la estructura demográfica, la dispersión, la tasa de mortalidad y otros (Kahn & de Granville 

1992).  

1.4. Presuposición filosófica  

 La presuposición de la investigación se basa en que Dios existe y es la fuente del 

conocimiento, que por el fueron creados todo el universo, incluyendo las especies que hay en 

el ecosistema.  

 En génesis 1:28 nos menciona que, al culminar la creación, Dios expreso que fructifiquen y 

multipliquen la tierra teniendo domino sobre ella al mismo tiempo que puede ser usada por el 

hombre (“Sagradas Escrituras,” 1569). 

En la creación el ser humano adopto de Dios la responsabilidad de cuidar y preservar el 

medio donde vivimos, porque desde tiempos atrás el hombre estuvo a cargo del jardín del edén.  

 La intención de la investigación se basa en el cuidado y preservación de una especie como 

es la Attalea Moorei, ya que en los últimos años las personas que se dedican a la agricultura 

están utilizando este cultivo para beneficio de ellos mismos. Es por ello que se plantea 

caracterizar la morfología y estructura poblacional de esta especie dado que con el pasar del 

tiempo ira disminuyendo la población.  

La naturaleza de Dios fue creada para protegerla y cuidarla, pero al mismo tiempo el hombre 

solo la utiliza para su beneficio, dando como resultados degradación del mismo habitad donde 

se encuentra. Dios concedió a los seres humanos de administrar y proteger el planeta en su 

lugar, en Salmos 8:6 nos habla acerca que todas las cosas nos han sido dadas con el único fin 

de gozar de un ambiente agradable ante los ojos de Dios. Nuestra responsabilidad ahora es 

cuidar la creación ya que día a día se observa cambios de temperatura debido a las actividades 

antropogénicas que han ido degradando el regalo que Dios nos brindó. 
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Las cosas de la naturaleza que hoy miramos nos dan sólo un débil concepto de la belleza y 

la gloria del Edén. La naturaleza testifica que Uno, infinito en poder, grande y bondadoso, 

misericordioso y amoroso, creó la tierra y la llenó con vida y felicidad. En las zarzas, los cardos, 

las espinas, las cizañas, podemos leer la ley de condenación; pero la belleza de las cosas 

naturales y de su maravillosa adaptación a nuestras necesidades y nuestra felicidad, podemos 

leer que Dios todavía nos ama, que su misericordia todavía se manifiesta en el mundo (White, 

2013). 
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CAPÍTULO II. 

REVISIÓN DE LA LITERATURA 

2.1. Antecedentes  

2.1.1.  Nivel internacional  

Jácome (2013), tuvo como objetivo principal analizar la estructura poblacional, 

productividad y fenología floral de Phytelephas aequatorialis en la costa ecuatoriana. Durante 

un año se estudiaron 2 poblaciones de Phytelephas aequatorialis (tagua) en la provincia de 

Manabí. En la población de Canuto, ubicada sobre un pastizal, los individuos están sometidos 

a la cosecha regular de hojas (cade) y semillas (tagua o marfil vegetal); mientras que la 

población de Junín forma parte de un bosque secundario en recuperación, cosechado 

esporádicamente. La estructura poblacional en Canuto se restringe a la presencia de plántulas y 

juveniles pequeños (0–1 m de altura) y adultos de categorías superiores (tronco de 4–8 m de 

alto); en cambio en Junín la población es más estable, aunque no cuenta con estadíos como 

juveniles de categorías superiores y sub-adultos. En ambas localidades la estación lluviosa se 

presentó desde enero hasta mayo de 2012. Es importante que se generen y se manejen 

adecuadamente los actuales terrenos de cosecha, sobre todo permitiendo la regeneración natural 

de las poblaciones de esta especie endémica del Ecuador occidental. 

Moreno (2010), se estudiaron las palmas de dos regiones fitogeográficas del Chocó, la Selva 

pluvial central (Tutunendo) y la Región del Rio San Juan (Angostura). Se establecieron 14 

transectos en Tutunendo, 10 de 100 x 5 m (5.000 m2) y cuatro de 500 x 5 m (10.000 m2), para 

un área total de 1.5 ha. En la segunda se establecieron 12 transectos, diez de 100 x 5 m (5.000 

m2) y dos de 500 x 5 m (5.000 m2), correspondientes a un total de 1 ha. En cada transecto se 

registraron y midieron todas las palmas, incluyendo todas las clases de tamaño (plántulas, 

juveniles y adultos), la información etnobotánica muestra que 28 de las 33 especies tienen 

reportes de uso en la comunidad. Se concluye que hay un grupo de especies (Wettinia quinaria, 
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Welfia regia, Iriartea deltoidea, Socratea exorrhiza, Oenocarpus bataua, en el dosel y 

Geonoma cuneata, en el sotobosque), que están presentes a todo lo largo y ancho y son 

importantes a nivel ecológico, y caracterizan y modelan la vegetación de la región del Chocó 

Biogeográfico. 

Picand (2006), el objetivo de este estudio fue analizar en base a mediciones morfológicas y 

fenológicas, la variabilidad en accesiones de A. Capillaris colectadas en diferentes ambientes 

de la Décima Región para determinar grupos de genotipos con características fenotípicas 

homogéneas. Se estudiaron accesiones provenientes de praderas de cuatro zonas 

edafoclimaticas; se utilizó un diseño experimental de bloques completos al azar con cuatro 

repeticiones y 100 tratamientos, realizándose un muestreo al azar de tres macollos en tres 

estados fenológicos: estado vegetativo con cuatro hojas, estado de bota y estado de grano 

maduro. También se evaluó largo y ancho de lámina, largo del macollo, largo de inflorescencia, 

número de hojas totales presentes en el macollo, número de hojas vivas presentes en el macollo, 

peso de los componentes del macollo y estado fenológico del macollo. Las diferencias 

significativas arrojadas por el análisis estadístico indican que A. Capillaris ha colonizado 

diversos ambientes en la zona sur de Chile mediante ecotipos. Por lo tanto, A. Capillaris 

poseería una combinación entre generación de ecotipos y plasticidad fenotípica como estrategia 

de colonización. 

González et al., (2012), el objetivo de esta investigación  fue caracterizar la densidad y la 

estructura poblacional de la palma bombona Iriartea deltoidea en un bosque de tierra firme de 

la zona sur del Parque Nacional Natural Amacayacu, en la Amazonia Colombiana. Se evaluó 

en seis parcelas de 1 ha y 90 transectos de 50 x 1 m, se censaron todos los individuos de la 

especie; para cada individuo se registró la altura del tallo, el estado morfológico de las hojas 
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(hojas enteras, hojas divididas, forma de las pinnas), la formación de raíz fúlcrea, la altura del 

cono de la raíz y el estado fenológico (brácteas, inflorescencias e infrutescencias). Se 

encontraron 2819 individuos que se agruparon en tres grandes categorías de edad 

significativamente diferentes (plántulas, juveniles I, II y adultos). Dentro de las 10 categorías 

etarias, la de Plántulas II fue la más densa, mientras que Juveniles I fue la menos densa; los 

adultos fueron ligeramente mayor a la de los Juveniles. Se concluye que la importancia de una 

refinada categorización etaria frente a categorizaciones realizadas a partir de variables 

morfológicas y estructurales permite caracterizar mejor el estado de las poblaciones de las 

especies con alta demanda. 

2.1.2. Nivel Nacional  

Macedo (2015), realizo el estudio de caracterizar morfológica y ecológicamente a dos 

poblaciones de palmera Attalea huebneri “shapaja”. En el estudio morfológico se evaluaron 71 

variables cuantitativas (vegetativas y reproductivas) en estadios adulto, juvenil III, juvenil II, 

juvenil I y plántula, de las cuales se compararon 55 variables entre las dos poblaciones. Once 

caracteres morfológicos (ocho vegetativos y tres reproductivos) diferencian de manera 

significativa (p≥ 0,05) a las poblaciones de A. huebneri de Jenaro Herrera y Bagazán. La 

caracterización ecológica consistió en la descripción de caracteres físicos del suelo, fisiografía, 

así como de la composición florística y estructura de los bosques de ambos sitios de estudio. 

Los resultados demuestran que existen caracteres morfológicos específicos que caracterizan a 

cada población de A. huebneri en las diferentes localidades, y que pueden crecer en distintas 

condiciones de suelo y asociadas a diferentes especies de árboles y palmeras. 

Machagua (2012), la investigación tiene como objetivo representar la distribución geográfica 

de las especies de la sección Huicungo del género Astrocaryum en el Perú y caracterizar la 

variabilidad vegetativa y estructura poblacional de Astrocaryum chonta y A. Javarense en la 
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zona de Jenaro Herrera, Requena, Loreto, Perú. Se establecieron 40 cuadrantes de 20 x 20 m en 

dos bosques de restinga y 40 cuadrantes en dos bosques de altura; en cada cuadrante se 

registraron datos cuantitativos de caracteres vegetativos y estructura poblacional de 

Astrocaryum chonta y A. Javarense por estadio de desarrollo (adulto, juvenil II, juvenil I y 

plántula). La comparación de la morfología vegetativa de Astrocaryum chonta y A. Javarense 

muestra diferencias significativas (p<0,01; 0,05) en 13 caracteres de adultos, 7 de juveniles II, 

5 de juveniles I y 1 de plántulas; a nivel de la estructura de las poblaciones, Astrocaryum chonta 

presenta en los bosques de restinga un número significativamente mayor de individuos juveniles 

I y plántulas que A. Javarense en los bosques de altura. 

Rimachi & Oliva (2016), esta investigación se estudia la estructura poblacional, densidad e 

índice de regeneración de palmeras Ceroxylon parvifrons (familia Arecaceae), especie 

distribuida en el bosque de palmeras del distrito de Molinopampa, Amazonas. Los resultados 

fueron obtenidos a través de la instalación de 5 parcelas no permanentes de 400 m2; se 

analizaron 1118 individuos que fueron clasificados en cinco categorías de crecimiento 

(plántulas, juvenil 1, 2, 3 y adulto reproductivo). La categoría plántulas presentó mayor 

densidad con 0,47 individuos/m2, juvenil 1 y juvenil 2. La estructura poblacional sigue el 

modelo de la J invertida, indicando una regeneración constante y se confirma con el índice de 

regeneración, ya que por cada adulto existen 85 plántulas. Este trabajo es una contribución al 

conocimiento sobre la población de la especie Ceroxylon parvifrons que posteriormente 

permitirá abordar problemas de manejo y conservación. 

2.2. Marco Teórico  

2.2.1 Descripción botánica  

   La especie según  (Pintaud, 2008) se clasifica de la siguiente manera: 

Reino  : Plantae  
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División             : Magnoliophyta  

Clase  : Liliopsida  

Sub-clase       : Commelinidae  

Familia  :           Arecaceae  

Subfamilia          :           Arecoideae 

Tribu  : Cocoeae  

Subtribu             :           Attaleinae 

Género           : Attalea  

Especie             : Attalea moorei 

Nombre común  :          Shapaja 

2.2.2 Descripción de la planta de Attalea moorei 

 Palmera: Tallo solitario de 14 m de alto, 25 a 40 cm de diámetro, el tronco está 

cubierto por las bases de las hojas.  

 Hojas: Comprenden de 11 a 30 aproximadamente con 2 m de largo, 245 pinnas 

dispuestas a cada lado en diferentes planos que le brindan a la hoja una apariencia 

desordenada.  

 Flores: Tiene dos tipos están las masculinas y femeninas en una misma planta, las 

cuales tiene racimos que salen del medio de la corona de hojas(Interfoliares) con un 

péndulo largo, flores femeninas globosas, amarillentas y numerosas con un fuerte 

olor dulzón.  

 Frutos: Son ovoides de 6-11 cm de largo, comprende una cascara dura (exocarpio), 

cuando madura es amarillenta, la pulpa interna (mesocarpio) es aceitosa, suave, 

cremosa y dulce.  
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 Semillas: Están dentro de un hueso leñoso (Endocarpio) y fibroso, alargadas son 

similares a las almendras Paniagua et al.,( 2012). 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

Figura 1. Descripcion de partes de Attalea moorei  

Fuente: (Amazonia Guia Ilustrada de Flora y Fauna, 2014) 

2.2.3. Usos 

Un estudio sobre las palmas útiles en los alrededores de Iquitos, refiere:  

  Medicinal: En los troncos caídos se desarrollan las larvas de un escarabajo, que también 

son llamadas Suri, las cuales son recolectadas para la alimentación de las personas y 

al mismo tiempo obtienen un ingreso económico. Las personas recolectan el Suri 

para extraer el aceite que tienen, este es utilizado para frotar las articulaciones de 
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personas con reumatismo, también el sector de los pulmones y para calmar el dolor 

de estómago.  

  Construcción: El tallo es utilizado para los postes de las viviendas, las hojas se utilizan 

para la construcción de techos en las casas, chozas de campo, gallineros, etc.  

  Herramientas y utensilios: Las hojas tiernas son utilizadas en la fabricación de canastos, 

abanicos, escobas; las larvas de coleóptero(suri) que se desarrollan en los frutos y 

tallos caídos son usados como carnada en la pesca.  

  Alimenticio: Los frutos maduros son colectados para que sean consumidos; las semillas 

son colectadas y consumidas como almendras crudas; las larvas (suri) que se 

desarrollan en los troncos en descomposición se cosechan y les sirve como alimento.  

  Los peciolos son utilizados para fabricar palitos que se usan en la elaboración de 

alimentos.  

  Las brácteas florales se recolectan para usarlo como recipientes o bateas en la cocina, 

cuando están secas se queman en las puertas de las casas para que el humo espante a 

los mosquitos.  

  Las semillas o venitas se sacan al quebrar el exocarpio, las personas extraen el aceite 

que es utilizado en casos de estreñimiento Paniagua et al., (2012). 

2.2.4 Morfología de las palmeras 

Al describir una palmera, es primordial tener en cuenta los caracteres relacionados al, hojas, 

inflorescencia, habito, frutos y semillas (Macedo, 2015).  

  Hojas  

Se encuentran agrupadas al final del tallo, formando una corona; se caracteriza por presentar 

una vaina que envuelve el tallo, un peciolo y las pinas que pertenecen a la lámina foliar, se 

difieren por su tamaño y forma de las cicatrices foliares (Galeano, 1991). 
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  Inflorescencia  

Pueden ser monoicas (con flores de ambos sexos en la misma planta) o dioicas (con flores 

de cada sexo en diferentes individuos), radica de un péndulo, que es la parte que se une a la 

planta un prófilo o bráctea basal con una o varias brácteas pedunculares que protegen a la 

inflorescencia durante su desarrollo; y un raquis a partir del cual salen las raquillas cortadoras 

de las flores (Galeano, 1991). Las inflorescencias pueden ser espigadas o ramificadas, la 

posición se encuentra entre las hojas (interfoliares), pero hay casos que está por debajo de la 

corona (intrafoliar), cuando se produce en las axilas de las brácteas es decir por encima de las 

coronas se llaman suprafoliares (Galeano, 1991). 

 Hábito 

El desarrollo de una palmera por lo general esta descrito como pequeño (menos de 3 m de 

altura), mediano (entre 3 – 10 m de altura), grande (más de 10 m de altura), y gigante cuando 

llegan a tener más de 20 m de altura y 25 cm de diámetro. Del mismo modo pueden tener 

troncos subterráneos con hojas saliendo del suelo (acaulescentes), cuando son notorios estos 

pueden ser solitarios o agrupados o en otros casos se encuentran sostenidos por raíces epigeas 

o pueden ser flexibles o trepadoras; habitualmente se encuentran cubiertos por restos foliares, 

como vainas, base de peciolos o pueden encontrarse cubierto por espinas (Borchsenius, 1998). 

 Frutos  

El tamaño y forma es muy variado existen desde menores de cinco milímetros hasta tamaños 

mayores; el epicarpio es liso presentando características como pelos, espinas o verrugas ; el 

mesocarpio puede ser carnoso-fibroso ; el endocarpio es el que envuelve a la semilla de grosor 

y dureza variables (Dransfield J et al., 2008). 

 Semillas  
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Las semillas tienen formas ovoide, elipsoidal y global; la mayor parte se encuentra cubierta 

por abundante endospermo nuclear de color blanco, rico en aceites, almidones y otros 

carbohidratos. Las venas son muy pequeñas, cónico o cilíndrico; de posición basal, lateral o 

apical. La germinación de las palmeras requiere de considerable humedad y protección de la 

luz solar ya que la mayoría se encuentran en áreas deforestadas (Dransfield J et al., 2008). 

2.2.5 Distribución del recurso 

La Shapaja es una especie inicialmente clasificada en el género Scheelea; en el Perú se 

encuentra por debajo de los 300 m.s.n.m., en las regiones de Huánuco, Loreto, Madre de Dios, 

Ucayali, San Martín. Esta especie es de amplia distribución, desde Centro América, hasta la 

parte oeste de la cuenca amazónica, debajo de los 300 m.s.n.m., en Perú (Huánuco, Loreto, 

Madre de Dios, Ucayali), Colombia (Amazonas, Caquetá, Putumayo), Venezuela (Amazonas, 

Bolívar), Ecuador (Napo), Brasil (Acre, Amazonas) y Bolivia (Cochabamba, La Paz, Pando). 

Habita en los bosques de tierra firme, pero es muy común en las márgenes de los ríos y en las 

zonas bien drenadas de la llanura de inundación en donde forma asociaciones relativamente 

densas llamadas "Shapajales" (Mejía,2004). 

En la región San Martín, distritos de Barranquita provincia de Lamas y de Chazuta, en 

potreros de pastos, se identificó, la presencia de 1 a 2 palmeras por hectárea, la misma 

distribución se encontró en potreros de Iberia en Madre de Dios, con 1 palmera por hectárea en 

promedio. Asimismo, en el río Chambira en la provincia de Loreto, se ubicó un bosque denso 

de Shapaja de varios cientos de hectáreas, en el ámbito de influencia de la comunidad Santa 

Cruz del Tagual (Carrasco, 2009). 

Por cada palmera de Shapaja se cuenta con 3 a 4 racimos de frutos, cada uno de 25 – 30 kg, 

de los cuales la tercera parte corresponde a la semilla, entonces por palmera, teniendo en cuenta 

solo tres racimos, se tiene 24-30 kg de semilla (Carrasco, 2009). 
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2.2.6 Distribución geográfica  

Dentro del contexto global de la distribución de las palmeras, la cual puede ser caracterizada 

como termocosmopolita, el continente sudamericano aparece como uno de los mayores centros 

de riqueza y diversidad para esta familia de plantas. Cuatro de las cinco subfamilias de palmeras 

existen en América del Sur: Calamoideae, Coryphoideae, Ceroxyloideae y Arecoideae. Tres 

tribus y subtribus son endémicas o subendémicas de América del Sur: Phytelepheae, 

Leopoldinieae y Mauritiinae, mientras algunos otros grupos Neotropicales presentan su mayor 

desarrollo en América del Sur (Iriarteae, Euterpeae, Manicarieae, Bactridinae), o no existen 

en otras partes del hemisferio occidental (Ceroxyleae). Dieciocho géneros son endémicos de 

América del Sur y algunos otros se destacan por su diversificación a nivel específico: Geonoma 

(69 spp.), Bactris (61 spp.), Attalea (56 spp.), Astrocaryum (39 spp.), Syagrus (35 spp.). En 

total, el continente suramericano contiene 459 especies que representan 50 géneros (Henderson, 

Galeano, & Bernal, 1995). 

2.2.7 Aspectos ecológicos de las palmeras e importancia económica  

En la amazonia peruana, los estudios en palmeras han sido especialmente orientados a la 

taxonomía de la planta , y por mucho tiempo se dejó de lado el aspecto ecológico (Mejia, 1993). 

Según Gutiérrez (2001) en la amazonia de Bolivia , se reportó poblaciones de varias especies 

de palmeras entre ellas del genero Attalea. En el Perú también se registraron estudios sobre 

aspectos ecológicos, pero mayormente sobre la especie Mauritia flexuosa “aguaje” 

principalmente a su valor socioeconómico y ecológico en el paisaje amazónico (Ochoa, 2003). 

Las palmeras son de especial importancia para muchos ecosistemas de la amazonia, tanto por 

ser las especies claves en muchos otros, donde sus frutos constituyen la base alimenticia de los 

animales durante las épocas del año donde no existe, o son escasos otros frutos. Si estos 

desaparecen, muchas de las especies de las plantas cuyas semillas son dispersadas por estos 
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agentes se verán afectado su reproducción y como consecuencia se desatará un efecto que 

degradara el bosque en su totalidad (Galeano et al., 2008). 

Para caracterizar el habitad donde las especies del genero Attalea se desarrollan, se requiere 

de conocimiento previo sobre características y tipos de formaciones vegetales de la amazonia 

peruana, ya que en la naturaleza no existen clases definidas de vegetación, las condiciones 

ecológicas suelen ser combinadas de cualquier manera; por ello solo es posible hacer una breve 

clasificación que aporta una abstracción y simplificación de la realidad (Macedo, 2015). Las 

palmeras de importancia económica se encuentran en seis ecosistemas forestales, caracterizados 

por su vegetación y suelo. 

2.2.8 Aspectos físicos  

Suelo: Es un componente importante en la caracterización de un habitad, muchas plantas 

necesitan para desarrollarse e incluso es posible clasificar de acuerdo al tipo de suelo en el que 

crecen (Escobedo, 2012). Existen diferentes tipos de suelo, la clasificación más sencilla es 

aquella basada en la textura, el cual se refiere a la composición granulométrica del suelo. Dichas 

partículas pueden ser pequeñas (arcilla), medianas (limo) y grandes (arena), estas fracciones me 

determinan la textura y al mismo tiempo establecen el desarrollo de las especies en cualquier 

tipo de suelo. 

Las palmas (Arecaceae) son uno de los grupos de plantas vasculares más exitosos de los 

trópicos, particularmente abundantes tanto en el sotobosque como en dosel de bosques 

húmedos. Según (Henderson & Tomlinson, 1991) se estima que cerca del 75% de las palmas 

del mundo se distribuyen en humedales de zonas tropicales, una importante proporción de ellas 

en el Neotrópico.  En general, las zonas bajas húmedas ricas en suelos aluviales poseen una 

mayor diversidad de palmas que los bosques situados en elevaciones medias y zonas 

montañosas, donde los suelos tienden a estar mejor drenado (Myers, 2013). 
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Clima: La shapaja se encuentra distribuido en toda la región amazónica, siendo resistente a 

los climas tropicales; esta especie tolera más o menos bien las temperaturas bajas, aunque su 

crecimiento es más lento. El frío reduce la actividad radicular, la tras locación de nutrientes y 

el crecimiento en general, debilitando a las plantas y haciéndolas más sensibles a los ataques de 

enfermedades; esta especie detiene su crecimiento si las temperaturas nocturnas son inferiores 

a 15°C. y sufren daños si descienden por debajo de los 13°C. Las temperaturas nocturnas de 

13°C y diurnas de 25°C son válidas cuando la iluminación, humedad ambiental y riegos son los 

adecuados (Kahn & Moussa, 1994). 

2.2.9 Productos forestales no maderables 

La especie Attalea moorei es un producto forestal no maderable y por su aprovechamiento 

se utilizan las maderas redondas para la construcción de viviendas rustica (estructuras de piso, 

pared y techo), las hojas de Irapay para cubrir las viviendas, las frutas de palmeras nativas como 

"Ungurahui" y "Aguaje" son, entre otros, los recursos forestales no maderables que las familias 

aprovechan con más frecuencia. El principal uso es por el fruto, cuyas almendras contienen 60 

a 70% de aceite vegetal, rico en ácido láurico, con composición similar al aceite de coco o al 

de la palma aceitera (Kahn, 1991). 

2.2.10 Importancia de los bosques  

Hoy en día se reconoce ampliamente la importancia de los bosques tropicales como fuente 

de los recursos forestales y de servicios ambientales recreacionales. Según (FAO, 1995) la 

reforestación de tierras agrícolas y pastizales abandonados ha formado una de las estrategias 

claves  para restaurar los servicios económicos y ecológicos de los bosques primarios. Los 

bosques húmedos tropicales antiguamente eran considerados frágiles y difíciles de recuperar, 

pero ahora un estudio revela que son resilientes ya que después de la intervención humana 
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pueden ser manejados para proporcionar muchos de los servicios ecológicos y económico 

suministrados por los bosques (Smith, 1997). 

2.2.11 Bosques estacionalmente secos 

Muchas veces cuando nos referimos a bosques secos pensamos en la costa norte de nuestro 

país donde crecen los algarrobos ( Piura, Lambayeque, etc.); del mismo modo consideramos 

que los bosques secos son áreas que se encuentran en estado de degradación o en estadío 

intermedio como son los bosques húmedos, que generalmente son atribuidos a acciones 

antrópicas ( como es la deforestación y sobrepastoreo) (Linares-Palomino, 2004). 

El bosque seco tropical se ubica principalmente en el valle del Huallaga central, las cuales 

abarca los alrededores de Tarapoto, Bellavista y Juanjui, también está en la unión de los ríos 

Perené, Ene y cerca de Quillabamba en alturas entre 300-850 msnm (Linares-Palomino, 2004). 

2.2.12 Situación crítica de las palmeras  

El aumento demográfico descontrolado ha provocado la sobreexplotación de las especies 

vegetales existentes en las zonas adyacentes, así como también en zonas de influencia de las 

comunidades rurales. Entre las especies vegetales más castigadas se encuentran aquellas que 

son demandadas por la industria maderera y otras como las palmeras cuyas hojas son utilizadas 

para la construcción de viviendas. El crecimiento de los asentamientos humanos en zonas 

aledañas a grandes bosques amazónicos, en los últimos años ha provocado la demanda interna 

y la perdida y alejamiento del recurso (Brañas, 2015). 

2.2.13 Estructura poblacional  

Los análisis de estructura poblacional se basan en la distribución y abundancia de individuos 

en diferentes categorías de edad o tamaño y reúne información relacionada con la dinámica de 

la población (Cortés-S  2003 , Anthelme & Pintaud 2010). Las categorías de edad reflejan el 

funcionamiento actual de la población, ya que mediante estas se documentan las presiones que 
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atraviesa dicha población además de proyectar su estado en un futuro  (Cortés-S  2003 , 

Anthelme & Pintaud 2010).  

2.2.14 Servicios ambientales de una planta endémica  

Los ecosistemas nos proveen el aire que respiramos, el agua que tomamos, es por esto que 

los seres humanos siempre han dependido de los servicios que el ecosistema les brinda (Dayli, 

1997). 

De acuerdo con el Millenium Ecosystem Assessment (MA) el impacto de las actividades 

humanas ha restringido la capacidad de los ecosistemas para mantener a la vida humana. El MA 

identifica cuatro tipos de servicios ambientales: los de aprovisionamiento, los de regulación, 

los culturales y los de soporte.   

• Los servicios de aprisionamiento son los bienes que materiales que benefician a los seres 

humanos, tales como agua o comida.  

•En los servicios de regulación encontramos el control de sequias, inundaciones y 

enfermedades.  

• Los servicios culturales son aquellos aspectos de especies y ecosistemas que proveen a los 

humanos experiencias recreativas, espirituales o religiosas. Mientras que los servicios de 

soporte son tangibles y fácilmente modificables. 

La palma provee todo tipo de servicios ambientales, los servicios de aprovisionamiento se 

obtienen de las hojas y frutos, la hoja es la más utilizada para la venta, elaboración de escobas, 

techos de las casas, como leña, alimento para ganado, etc. En los servicios culturales la gente 

reconoce los servicios de regulación de la palma, ya que es un recurso abundante y 

aprovechable.   
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2.2.15 Servicios ambientales en secuestro de carbono 

Evaluar los servicios ambientales con énfasis en el secuestro de carbono, involucra plantear 

métodos adecuados que permita cuantificar el carbono, tanto de la biomasa presente en la 

vegetación superficial, en las raíces, en el suelo y la necromasa. 

Para la estimación de la biomasa se puede utilizar un método destructivo y uno no 

destructivo. El método destructivo consiste en la extracción física de los árboles, este proceso 

consumo gran cantidad de tiempo y recurso. El método no destructivo no implica el volteo del 

árbol, por lo que un mayor número de árboles puede ser muestreado (Brown, 1992).  

2.2.16 Servicios ambientales del bosque  

La evaluación económica de los servicios ambientales se ha centrado en cuatro bloques 

fundamentales: biodiversidad, fijación de carbono, ciclo hidrogeológico y educación. La 

conservación de la biodiversidad, la protección de los suelos y las cuencas hidrográficas son 

servicios que desde hace mucho tiempo son reconocidos y viendo siendo una fuente de recursos.  

Los bosques cumplen una serie de funciones ecológicas como son: el reciclaje de nutrientes, 

mantenimiento de los suelos, fijación y almacenamiento de carbono, respiración de seres vivos, 

protección de hábitats para flora y fauna, regulación del clima, calidad de aire, régimen y 

calidad de aguas entre otros (Sarasibar, 2007).  

2.2.17 Modelo para predecir la distribución de una espécie 

El modelo se basa en el princio  que la distribucion estimada de una especie debe coincidir 

con la distribucion conocida a partir de las condiciones ambientales donde ha sido observada. 

El procedimiento consiste en usar algoritmos computarizados para generar mapas predictivos 

sobre la distribucion potencial de especies en el espacio geográfico a partir de las distribuciones 

de la especie en el espacio ambiental. 
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Su elaboración requiere modelos tipo campo que representen la distribución espacial de las 

variables ambientales (capas) y un conjunto de puntos georrefrerenciados que indiquen donde 

esta presente la especie. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 2. Descripcion de los pasos a seguir para obtener un modelo de distribución  

Fuente: (Martin, 2016) 

La distribución de especies puede variar extensamente de un punto a otro, gradientes 

ambientales como la humedad, drenaje, pendiente, tipo de suelo e intensidad de luz, influyen 

en el aspecto del modelo horizontal dentro de un bosque. (Brower et al., 1990). 

La distribución espacial de los individuos por especie es un factor fundamental para 

determinar el efecto de sucesos pasados sobre el patrón de distribución actual, lo cual permite 

generar hipótesis sobre los procesos biológicos o ambientales que estructuran los bosques 
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tropicales (Dale, 1999). Así como la distribución espacial de las especies de árboles en los 

bosques tropicales provee información fundamental acerca de su historia natural, dinámicas 

poblacionales y competencia; así como sobre los procesos que mantienen y regulan la 

biodiversidad (Dale, 1999). 

Wiegand et al., (2007) indican que los patrones espaciales son el resultado de procesos 

diferentes que operan en distintas escalas y guardan relación con los síndromes de regeneración 

propios de las especies (modos de dispersión, tolerancia a la sombra, establecimiento, 

supervivencia y desarrollo) y con la heterogeneidad ambiental. 

2.3. Definición de términos  

 Abaxial: El lado de un órgano que se proyecta fuera del eje que lo sostiene, por ejemplo, 

la superficie inferior de una hoja, la superficie inferior de un peciolo o la superficie 

exterior de una bráctea tubular (Dransfield, et al., 2008). 

 Acaulescente: Se refiere a la especie o categoría de crecimiento de una palmera cuyo 

tronco no es visible (Dransfield, et al., 2008). 

 Adaxial: El lado de un órgano que se proyecta hacia el eje que lo sostiene (Dransfield, 

et al., 2008). 

 Ápice: Punto o extremo máximo opuesto a la base de una palmera; aplicado también a 

sus órganos o partes (Dransfield, et al., 2008). 

 Aurícula: Lóbulo con forma de oreja en algunas especies pueden presentar formas 

acuminadas o puntiagudas (Dransfield, et al., 2008). 

 Basal: Punto o extremo máximo opuesto al ápice de una palmera; aplicado también a 

sus órganos o partes (Dransfield, et al., 2008). 

 Bráctea: Hoja modificada asociada con la inflorescencia (Dransfield, et al., 2008). 
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 Bractéola: Una pequeña protuberancia floral unida a la bráctea, regularmente presente 

cuando la flor es esencialmente sésil (Dransfield et. al; 2008). 

 Bífido: Es el órgano que se encuentra dividido en dos partes en el ápice (Font, 2017). 

 Cáliz: Es el perianto formado por los sépalos (Font, 2017). 

 Caule: Se refiere al tallo de la palmera (Dransfield, et al., 2008). 

 Compuesta: Es la hoja dividida en segmentos o foliolos (Dransfield, et al., 2008). 

 Conglomerado: Un conglomerado es un conjunto espacialmente compacto de unidades 

muestrales (Food and Agriculture Organization - United Nations) (Font, 2017). 

 Corona: Un conglomerado de hojas originadas en el tronco (Dransfield, et al., 2008). 

 Cotiledón: La hoja primaria desarrollada por el embrión de la semilla de una palmera 

(Font, 2017). 

 Estigma: Es parte del carpelo diferenciado, situada en su extremo libre y está destinada 

a recibir el polen (Font, 2017). 

 Estilo: En el carpelo existe un prolongamiento filiforme del ovario, que termina en el 

estigma (Font, 2017). 

 Eófilo: Es la primera hoja de una planta (Dransfield, et al., 2008). 

 Estípite: Se llama así al tallo largo no ramificado presentes en plantas arbóreas, 

principalmente son el tronco de las palmeras (Dransfield, et al., 2008). 

 Epicarpio: Capa externa de la pared del fruto de una planta (Font, 2017). 

 Mesocarpio: Es la capa media de la pared del fruto de una planta (Font, 2017). 

 Endocarpio: Capa que se encuentra después del mesocapio y está más cerca a la semilla 

del fruto (Font, 2017). 

 Flora: Conjunto de plantas que se encuentran en una determinada región (Font, 2017). 
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 Infrutescencia: Conjunto de frutos sobre un receptáculo en común (Dransfield, et al., 

2008). 

 Manchal: Se denomina manchal a un área de bosque donde se agrupan individuos 

forestales de la misma especie (Dransfield, et al., 2008). 

 Marcescentes: Son las hojas que se secan en la misma planta (Dransfield, et al., 2008). 

 Morfología: Es la ciencia de la forma, en botánica estudia la forma de las plantas en sus 

distintas fases que tienen (Font, 2017). 

 Peciolo: Pedúnculo que sostiene las hojas y los une al tallo (Dransfield, et al., 2008). 

 Pedúnculo: Eje que sostiene una flor, inflorescencia. infrutescencia (Dransfield, et al., 

2008). 

 Perianto: Formado por cáliz y corola (Dransfield, et al., 2008). 

 Pinna: Son hojas pequeñas que salen de una hoja pinnada o también de una nerviación 

principal (Font, 2017). 

 Raquis: Eje del que nacen los foliolos de una hoja, inflorescencia o infrutescencia 

posterior a la primera hoja (Font, 2017). 

 Raquilla: Eje que sostiene flores (Dransfield, et al., 2008). 

 Receptáculo: Es la base que sirve de soporte a las diversas flores de una inflorescencia 

(Dransfield, et al., 2008). 

 Suelo: Es la capa superficial de la corteza terrestre en las cuales se encuentran 

hospedados números organismos, del mismo modo es soporte para las plantas y 

contiene números elementos nutritivos para su desarrollo (Font, 2017). 

 Bosques estacionalmente secos: Son los ecosistemas con densa vegetación arbolada 

que alberga climas estacionales lluviosos, hoy en día están bajo mayor amenaza en 
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todo el mundo, ya que cada vez se incrementa la demanda para zonas de agricultura, 

la deforestación con fines maderables (Linares, 2004). 

 Vaina: Base de la hoja más o menos ensanchada, que abraza el tallo (Font, 2017). 

2.4.  Marco Normativo  

Ley General del Ambiente  

La ley N°. 28611 (2005) el Art.1 Menciona que “Toda persona tiene el derecho irrenunciable 

a vivir en un ambiente saludable, equilibrado y adecuado para el pleno desarrollo de la vida; el 

deber de contribuir a una efectiva gestión ambiental y de proteger el ambiente, así como sus 

componentes, asegurando particularmente la salud de las personas en forma individual y 

colectiva, la conservación de la diversidad biológica, el aprovechamiento sostenible de los 

recursos naturales y el desarrollo sostenible del país”. 

Constitución Política del Perú 

En el artículo 66 indica que los recursos naturales, renovables y no renovables, son 

patrimonio de la nación, el estado es soberano en su aprovechamiento; la ley orgánica se fijan 

las condiciones de su utilización y de su otorgamiento a particulares. En el artículo 67 se basa 

que el estado promueve el uso sostenible de los recursos naturales del mismo modo está en la 

obligación de preservar la diversidad biológica de acuerdo a ley. 

Ley sobre la Conservación y Aprovechamiento Sostenible de la Diversidad Biológica 

La ley N° 26839 en el marco del desarrollo sostenible, la conservación y utilización 

sostenible de la diversidad biológica declara de prioridad e interés nacional investigaciones 

científicas sobre: Estudios de flora, fauna, microorganismos y ecosistemas mediante la 

realización de inventarios, estudios biológicos y de seguimiento ambiental mediante la 

aplicación de metodología que favorezcan a las mismas en su desarrollo. 
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Política Nacional del Ambiente  

El D. S. N° 012-2009-MINAM, constituye la Política Nacional del Ambiente, destacando la 

conservación y aprovechamiento de la diversidad biológica, también impulsando la importancia 

de los bosques estableciendo políticas sobre conservación que permitan de tal modo prevenir la 

deforestación de sus recursos; difundiendo las buenas prácticas de reforestación e incorporando 

mecanismos de vigilancia para hacer cumplir los derechos forestales. 
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CAPÍTULO III 

MATERIALES Y MÉTODOS 

3.1. Área de estudio  

La presente investigación se encuentra ubicada en dos localidades de la región San Martin: 

Pucacaca (X: 338199- Y: 9243233) perteneciente a la provincia de Picota, y San Pedro de 

Cumbaza (X: 0345158- Y: 9289731) a la provincia de San Martin ( Tarapoto) y  ambas se 

ubican en la region San Martin. La primera zona se encuentra situada en el Área de Concesión 

para Conservación Ojos de Agua, los propietarios del predio es la Asociación Bosques del 

Futuro Ojos de Agua (ABOFOA). La segunda zona está ubicada en el sector Trancayacu (Fundo 

Pedrito), carretera San Pedro de Cumbaza, el propietario del terreno es el señor Wildoro Huansi 

Soriano. Las zonas donde se realizó el muestreo son parcelas de bosques estacionalmente secos 

donde abundan la especie Attalea moorei (Shapaja) (Ver Figura 3. –Ubicación de las dos zonas 

de estudio distrito de Pucacaca y San Pedro de Cumbaza). 

3.2.  Accesibilidad  

El distrito de Pucacaca es accesible por vía terrestre, por la carretera Fernando Belaunde 

Terry se traslada por medio de camionetas, autos o motos, pasando por varios caseríos y se 

llegan al destino aproximadamente entre 40 a 50 min, luego para ir a la Concesión Ojos de agua 

se camina 2 horas dentro del bosque hasta llegar al lugar de estudio. El centro poblado de San 

Pedro de Cumbaza también se traslada por vía terrestre, por medio de motos o carros abarcando 

unos 15 a 20 min para llegar al destino. 

3.3. Clima  

Las temperaturas alcanzan un promedio de 21.1° C (mínima) y 33.4° C (máxima), mientras 

que las precipitaciones llegan hasta 99 mm (mínima) y 102 mm (máxima) anuales. Las 

precipitaciones más frecuentes sucede entre los meses de Noviembre a Marzo  y otro periodo 
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de precipitaciones esta entre los meses de febrero a abril, mientras que de Mayo a octubre son 

llamados meses secos.(Climate-data, 2017).  
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Figura 3. Mapa de ubicación de colecta de Attalea moorei del distrito de Pucacaca y San Pedro de Cumbaza en el bosque estacionalmente seco del 

Huallaga- región San Martin   

           Fuente: Elaboración propia, 2019
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3.4. Fisiografía  

Las zonas de muestreo pertenecientes a la región San Martin están compuestas por 

estructuras fisiográficas irregulares con presencia de condiciones climáticas diversas que varían 

con la altitud en cada época del año; los sectores poseen relieves bajos y lomadas formadas por 

montañas, siendo la fuente hidrográfica el rio Huallaga la cual discurre por las provincias, 

distritos y centros poblados; a su vez estas formaciones montañosas generan un paisaje 

amazónico rico en vegetación acompañadas de precipitaciones que generan zonas de diversas 

especies de flora y fauna ( Martin, 2013). 

3.5. Suelos  

Los suelos de los bosques secos están formados por suelos originados a partir de sedimentos 

aluviales de color pardo amarillento a pardo rojizo; con textura moderadamente fina (arcilla 

sobre franco arenoso), presentan pH alcalino entre 7.0 – 7.9; las capacidades naturales de estas 

tierras están orientado para protección, cultivo permanente y producción forestal (Rogers & 

Ramirez, 2009). 

Los suelos de la región San Martin son superficiales, formado por capas de materia orgánica 

con derivados de calizas y materiales arcillosos, dependiendo de su fertilidad estos pueden ser 

para uso agropecuario, producción forestal y protección (Mateo, Arana, & Flor, 2006). 

 

3.6. Vegetación 

Los bosques secos comprenden menos de la mitad de los bosques tropicales y sub-tropicales 

en el mundo (Sunderland & Apgaua, 2015), los que se encuentran en los neotropicos se 

distribuyen de manera fragmentada desde México hasta Argentina, y dentro del Perú se 

encuentran distribuidos en tres regiones geográficas distintas (Linares-Palomino, 2004). 
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La vegetación comprende bosques secundarios (290-600 msnm) los cuales se caracterizan 

por estar compuesto de especies que prefieren lugares abiertos y con mucha luz. Estudios de 

estructura y composición florística fueron realizados por el Instituto de Investigaciones de la 

Amazonia Peruana y otras instituciones más a través del inventario biológico en los bosques 

estacionalmente secos del Huallaga central, San Martin-Perú; las especies encontradas son: 

Cecropia polystachia, Cecropia engleriana, Ficus caballina, Ochroma pyramidale, Cordia 

alliodora, Erythrina sp.2, Tabebuia spp., Tabernaemontana cymosa, fueron comunes en el 

estrato superior. Entre los arboles pequeños y arbustos se encontraron: Dictyoloma 

vallendianum, Piper spp., Senna loretensis, Vachellia farnesiana, Cordia nodosa, Maclura 

tinctoria, Inga spp., Condaminea corymbosa, Vernonanthura patens, Tournefortia 

hirsutissima, Vismia sp.1. Entre las hierbas sobresalieron: Biophyton sp.1, Chloris radiata 

Geophila macropoda, Heliconia juruana, Heliconia hirsuta, Ruellia blechum; finalmente entre 

Lianas y bejucos estuvieron: Celtis iguanae, Rynchosia sp.1, Hiraea sp.1, Merremia sp.1, 

Serjania spp., Paullinia spp., y Uncaria tomentosa. 

La vegetación en las dos zonas de muestreo corresponde a bosques secos y húmedos con 

pisos pre-montanos, bajo montano y montano; ocupan mayormente colinas bajas y lomadas, así 

como las planicies y terrazas aledañas a los diferentes ríos que discurren. La diversidad vegetal 

está formada por especies sin flores (Criptógamas como algas, hongos, etc.), y con flores como 

las monocotiledóneas y dicotiledóneas, que crecen en hierbas, enredaderas, arbustos, arboles, 

que aprovechan los amplios espacios de colinas, rocas y suelos creando hábitats y ecosistemas 

de vida (Martin, 2013). 

3.7. Materiales  

Tabla 1.  

Listado de materiales utilizados en campo y gabinete  
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Etapa  Materiales  Cantidad     Usos 

 

 

 

 

 

 

 

 

 

 

Campo 

Bolsa polietileno 4 und Se utilizó para colocar las 

muestras de suelo de los dos lugares 

de estudio. 

Machete 2 Sirvió para cortar malezas y hacer 

caminos para delimitar el área. 

Costales 2 und Se colocó dentro el material 

vegetal colectado en campo. 

Pala 1 Sirvió para remover la tierra y 

hacer calicata 

Botas 2 pares Protegió los pies de las diferentes 

cosas que se pueden encontrar en el 

suelo como los insectos. 

Pilas AA (Duracell) 2 pares Sirvió para el funcionamiento del 

GPS 

Rafia 4 rollos  Se utilizó para delimitar y cerrar 

las subparcelas de estudio. 

Hilo pabilo 1 Se utilizó para amarrar las 

prensas y colocarlo al secador. 

Cinta métrica de 

50(m) 

1 Se utilizó para medir las 

distancias de las subparcelas, 

también las hojas de la parcela. 

Tijera podadora de 

mano 

1 Se usó para cortar partes de la 

palmera en estudio 

Alcohol 1 Sirvió para conservar las 

muestras colectadas en campo. 

Plumón indeleble 2 und Se usó para colocar códigos cobre 

las bolsas. 

Cuaderno de 

apuntes 

1 Se usó para realizar apuntes de 

los datos de campo estudiados. 

Tablero 1 Se coloco las formatos de 

evaluacion  

Brújula 1 Nos ayudó a señalar el norte 

magnético y también a delimitar las 

subparcelas. 

Clinómetro 1 Se estimó la altura de las 

palmeras 

Cámara fotográfica 1 Sirvió para tomar fotografías de 

las características del bosque, suelo 

y palmera del área de estudio. 

GPS 1 Facilito las coordenadas 

geográficas del cada cuadrante de 

los lugares de estudio. 
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Lápiz 3 und Se utilizó para escribir sobre el 

formato de campo establecido. 

Papel bond A4 1/2 millar Sirvió para imprimir los formatos 

de evaluación y tesis concluida 

Estacas de madera 40 und Se utilizó para colocarlos en cada 

punto de cuadrante establecidos. 

Capa impermeable  1  Para protegernos de la lluvia y 

así cubrir los materiales que se 

estaban utilizando. 

Gabinete Laptop HP 1 Permitió analizar, procesar la 

información recolectada.  

Software ArcGIS 

10 

..  Se realizó por medio de este 

programa la creación del mapa de 

estudio. 

USB 8 GB 1 Guardo y conservo la 

información trabajada en gabinete. 

Fuente: Elaboración propia, 2019 

 

3.8. Descripcion de variables  

3.8.1 Variable dependiente 

        Estructura poblacional de Attalea moorei. 

3.8.2 Variable Independiente 

         Dos parcelas del Bosque estacionalmente seco del Huallaga. 

3.9. Hipótesis de la investigación  

       Hipótesis general  

       Ha: Existe diferencia significativa en la estructura poblacional de Attalea moorei en las 

dos parcelas del Bosque estacionalmente seco del Huallaga, San Martin-2019. 

       H0: No existe diferencia significativa en la estructura poblacional de Attalea moorei en las 

dos parcelas del Bosque estacionalmente seco del Huallaga, San Martin-2019 

3.10. Población y muestra   

3.10.1. Población 

Para realizar este trabajo se consideró población 2770 individuos de Attalea moorei, en sus 

diferentes categorías de crecimiento (Categoría I, II, III, IV), conformada por 20000 m2 (2 ha.)  
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de bosque con presencia de la especie en estudio, lo que equivale a 2 parcelas de 13 subparcelas 

cada una, sumando un total de 26 subparcelas de 20m2 situadas en el bosque estacionalmente 

seco del Huallaga.  

3.10.2. Muestra  

Las muestras para realizar el estudio fueron todos los individuos de categoría (I, II, III y 

adultos), conformada por 10000 m2 (1 ha) de bosque con presencia de especie en estudio, lo 

que equivale a 13 subparcelas de 20m2; que se registraron en dos parcelas permanentes del 

centro poblado San Pedro de Cumbaza y distrito de Pucacaca 

3.10.3. Instrumentos de recolección de datos  

Los instrumentos de recolección de datos en la presente investigación se relacionan con 

fichas de registro de campo para categorías de crecimiento (I, II, II y adultos). 

Tabla 2.  

Modelo de formato de campo empleado para el censo de individuos de Shapaja (Attalea 

moorei). 

N° de 

Subparcel

as 

N° de 

Palmeras 
Lugar 

Catg.Creci

m. 

Altura 

horizonte 

observador 

Alt.

Total 

(cm) 

Georrefe

. 

S1 1     S.P      I 1.65 90  x,y 

… … …     … … … … 

S13 1 S.P      II 1.65 3.1 x,y 
Fuente: Elaboración propia 2019 

3.10.4. Análisis de datos  

La estructura poblacional de las parcelas evaluadas siguió un procedimiento primero de 

estadística descriptiva, seguido de la prueba no parametrica de Kruskal-Wallis para determinar 

si existe diferencias entre ambas poblaciones en los dos diferentes lugares. 

Se empleó el programa Microsoft Excel 2016 para la sistematización de datos y el software 

libre R versión 3.5.1 que sirvió para evaluar la estadística descriptiva, prueba no parametrica 

de Kruskal-Wallis. Para los análisis de datos georreferenciados de la especie Attalea moorei se 
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empleó el software ArcGIS 10.2.2 y el software Maxent para realizar la distribución espacial 

de la especie. 

Para la caracterización de suelo los datos observados se analizaron mediante una estadística 

descriptica de características in situ de los dos lugares de estudio. 

Los datos de estructura poblacional se analizaron analizados mediante una estadística 

descriptiva y la prueba no parametrica de Kruskal-Wallis para determinar si existen diferencias 

de ambas poblaciones de Attalea moorei en las dos parcelas en un bosque estacionalmente seco. 

 Media. Se determinará tras sumar los valores de los conjuntos de observaciones 

(ejemplo: individuos adultos, número de hojas, altura de estípite, etc) y dividir dicha 

sumatoria entre el número total de observaciones para cada caso, obteniendo la media 

o promedio aritmético.  

 Desviación estándar. Son medidas o valores que indican la dispersión de las 

observaciones (N° de hojas, altura de estípite en metros, altura de palmera en metros, 

etc.) con respecto a la media. Se determinaron bajo la siguiente fórmula: 

 

𝝈 = √
∑ (𝒙𝒊 − 𝒙̅)𝟐𝒏
𝒊𝟏

𝑵
 

 

 Prueba no parametrica de Kruskal-Wallis.  Es un método no paramétrico 

para probar si un grupo de datos proviene de la misma población. 

Intuitivamente, es idéntico al ANOVA con los datos reemplazados por 

categorías, esta prueba evalúa la diferencia significativa entre las medias de 

dos grupos o dos categorías dentro de una misma variable dependiente 
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(estructura poblacional y las dos parcelas del bosque estacionalmente seco del 

Huallaga). 

 

Para concluir si existe diferencia significativa de estructura poblacional de las dos 

poblaciones de Attalea moorei en los lugares de San Pedro de Cumbaza y Pucacaca, se utilizó 

la prueba no parametrica de Prueba de Kruskal-Wallis; la cual nos permitió los análisis y 

comparar los datos cuantitativos de estructura poblacional de las categorías de crecimiento: 

categoría I, II, III, IV y las dos parcelas del bosque estacionalmente seco del Huallaga. Los 

resultados se obtuvieron del software libre R versión 3.5.1 del cual se trabajó con significancia 

de p<0,01, p<0,05, p>0,05. 

3.10.5. Registro de altura de palmera con uso de clinómetro 

 

 

 

 

 

 

 

Figura 4. Esquema del registro de altura de palmera con uso de clinómetro 

Fuente: Elaboración grafica del equipo técnico del proyecto 

Donde:  

h1 = Altura del horizonte del observador. 

h2 = D * Tan(β) 

h3 = D * Tan(α) 

D = Distancia entre el árbol y la persona que realiza la medición. 

Altura del estípite = h1 + h2 

Altura total (de la palmera) = h1 + h2 + h3 

β 

h3 

h1 

α 

D 

(Altura del 

horizonte del 

observador) 

h2 
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Altura de la corona = Altura total - Altura del estípite. 

3.11. Metodología 

Las salidas al campo se realizaron en 3 semanas con duración de 20 días, cada uno estuvo 

programada de acuerdo a los objetivos de la investigación. Al concluir el trabajo se plasmó el 

trabajo de gabinete. 

3.11.1 Instalación y subdivisión de parcelas permanentes  

Se adaptó la metodología detallada en el “Manual de campo para el establecimiento y 

remedición de parcelas” de la Red Amazónica de Inventarios Forestales – RAINFOR (Zea, 

2001). Se seleccionaron aleatoriamente 13 sub-parcelas para realizar el estudio. 

Se instaló dos parcelas de 1 ha (100 x 100 m), en el centro poblado San Pedro de Cumbaza 

y Pucacaca. Cada parcela se delimito aleatoriamente con la ayuda de rafias, brújula, cinta 

métrica de 50 m, machetes y cintas; y fueron divididas en 13 subparcelas de 20 x 20 m (0,05 

ha)(Macedo, 2015). 

Figura 5. Diseño de parcela permanentes de muestreo en el Centro poblado San Pedro de Cumbaza  

Fuente: Elaboración propia, 2019 



53 

 

Figura 6. Diseño de parcela permanentes de muestreo en el Distrito de Pucacaca (Ojos de agua) 

Fuente: Elaboración propia, 2019 

3.11.2 Registro de Individuos  

En ambas zonas de estudio, y en cada subparcelas seleccionada se registró: número de 

individuos, altura total, números de hojas, longitud de hojas, también se tomó nota del estado 

reproductivo de la palmera. La altura se midió con Clinómetro; la altura del estípite corresponde 

desde la base de la palmera hasta la aparición de la primera hoja del tronco. Para medir el 

diámetro de utilizo una cinta métrica y las mediciones de hicieron a 1,30 m de altura del suelo. 

3.11.3 Métodos de muestreo y toma de datos  

Las palmeras fueron muestreadas según la frecuencia de la especie, por cada cuadrante se 

registró la altitud y las coordenadas con un GPS Garmin; el número total de puntos considerados 

para elaborar el mapa incluye: todas las palmeras evaluadas y georreferenciadas durante el 

estudio. 

La metodología empleada para la herborización de muestras biológicas de la especie en 

estudio fue extraída de un curso de botánica tropical, dictado en la localidad de Jenaro Herrera, 

Región Loreto, Perú .(Fine, Zárate, Vriesendorp, & Baker, 2015). 

3.11.4 Determinación de la estructura poblacional  

La definición de las categorías de crecimiento de la especie en estudio se realizó de acuerdo 

a la recomendación de Henrik Balslev (Balslev, 2010)  donde recomienda que las categorías de 
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edad de las palmas corresponden a plántulas, juveniles, pre-adultos y adultos, dicha referencia,  

la observación in-situ y algunos criterios morfológicos discutidos por parte del equipo técnico 

del proyecto en 2014, fueron la base para definir las categorías de crecimiento. 

El muestreo de los individuos de la especie en estudio se realizó en 13 subparcelas 

seleccionadas, también se logró tener un inventario por categoría de crecimiento de todos los 

individuos de la especie Attalea moorei localizada en cada sub-parcela. En relación con los 

individuos identificados como adultos, se realizaron mediciones empleando un clinómetro 

SUUNTO Tándem, registrando la altura del estípite, asimismo la altura total y se tomó datos 

de ubicación de cada sub-parcelas, y posterior prensado de muestras. 

En cada cuadrante se contaron todos los individuos presentes de Attalea moorei por categoría 

de desarrollo: Categoría I, Categoría II, Categoría III y Categoría IV. (Tabla N°3) 

Tabla 3. 

 Categorías de Crecimiento para Attalea moorei en las dos localidades de estudio. 

Fuente: Equipo técnico del proyecto, 2014 

 

3.11.5 Caracteres morfológicos vegetativos  

Para la descripción morfológica se seleccionó al Azar una palmera de las distintas categorías 

de crecimiento por cada localidad de estudio. La elección consistió en observar los individuos 

Categoría I Incluye plántulas, plantones y aquellos 

individuos en desarrollo que no exceden los 3 mts. 

de altura. (Regeneración) 

Categoría II Individuos en un estadío juvenil, que superan los 

3 mts. de altura, acaulescentes. (Juveniles) 

Categoría III Individuos con todas las características de un 

adulto, pero sin evidencias de infrutescencia o 

inflorescencia. (Sub-adultos) 

Categoría IV Individuos adultos - maduros, reproductores. 

(Adultos) 
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que presentan rasgos vegetativos (estípite, hojas) y reproductivas (inflorescencia, 

infrutescencia) sanas, completas y accesibles de medir. 

Tabla 4.  

Carácteres vegetativos considerados en el registro de datos en las dos localidades 

Estadio Caracteres vegetativos  Descripción  

Plántula Numero de hojas 

Largo del peciolo (cm)  

Largo raquis (cm)  

Ancho lámina ( cm)  

De 3 individuos 

De 3 hojas de los 3 individuos 

De 3 hojas de los 3 individuos 

De 3 hojas de los 3 individuos 

 

Juvenil I 

Juvenil II 

Altura total (cm)  

Numero de hojas  

Numero de pinnas  

Largo vaina-peciolo (cm) 

Largo raquis (cm)  

Largo pinna distal (cm) 

Ancho pinna distal (cm)  

Largo pinna media (cm) 

Ancho pinna media (cm) 

Largo pinna proximal (cm) 

Ancho pinna proximal 

(cm) 

Largo aguijones vainas 

(cm) 

 

De un individuo 

Totales del individuo 

De ambos lados de 1 hoja 

De 1 hoja del individuo 

De 1 hoja del individuo 

Una pinna de una hoja del 

individuo 

Una pinna de una hoja del 

individuo 

Una pinna de una hoja del 

individuo 

Una pinna de una hoja del 

individuo 

Una pinna de una hoja del 

individuo 

Una pinna de una hoja del 

individuo 

5 aguijones más grandes de la 

vaina del individuo 

Adulto Altura total (cm)  

Largo del tronco (cm) 

Diámetro del tronco (cm) 

Número de hojas  

Número de pinnas  

Largo vaina- peciolo (cm) 

Largo raquis (cm) 

Largo pinna distal (cm) 

Ancho pinna distal (cm) 

Largo pinna media (cm) 

Ancho pinna media (cm) 

Largo pinna aproximal 

(cm) 

De un individuo  

Del individuo escogido 

Del individuo escogido 

Totales del individuo  

De ambos lados de 3 hojas del 

individuo 

De las 3 hojas  

De las 3 hojas  

3 pinnas de las 3 hojas del 

individuo 

3 pinnas de las 3 hojas del 

individuo 

3 pinnas de las 3 hojas del 

individuo 
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Caracteres vegetativos del estadio II que fueron considerados en las dos localidades de estudio  

Fuente:(Gonzalez, 2012) 

Se consideró las variables cualitativas y cuantitativas (señaladas en la tabla 4), asimismo se 

añadieron datos: altura total, diámetro de estípite. Se registró la máxima cantidad de datos 

morfológicos vegetativos según las categorías de crecimiento. 

Se describieron 14 caracteres vegetativos en 1 individuo de San Pedro de Cumbaza y 1 de 

Pucacaca (Ojos de agua) (Tabla 4). Los datos evaluados fueron: altura total, altura y diámetro 

del estípite, número de hojas corona, número de pinnas, largo vaina del peciolo, largo del raquis, 

largo de la pinna distal, ancho de la pinna distal, largo de la pinna media, ancho de la pinna 

media, largo de la pinna proximal, ancho de la pinna proximal, largo de 5 pinnas más grandes 

de la vaina. 

3.11.6 Colecta e identificación de muestras  

En las dos zonas de estudio se colectaron muestras fértiles de Attalea moorei; se utilizó un 

machete, tijera podadora y cinta maskintape, y las muestras fueron codificadas de esta forma:  

ATMCG 001 = Para el Centro poblado San Pedro de Cumbaza 

ATMCG 002 = Para el Distrito de Pucacaca (ojos de agua) 

Para el prensado de las muestras botánicas se utilizó papel periódico donde fueron colocadas 

entre dos láminas de cartón y aluminio seguido se formó una pila que fue sujetada entre dos 

prensas con ayuda de hilo pavilo. 

Ancho pinna aproximal 

(cm) 

Largo aguijón vaina (cm) 

  

3 pinnas de las 3 hojas del 

individuo 

3 pinnas de las 3 hojas del 

individuo 

3 pinnas de las 3 hojas del 

individuo 

5 aguijones más grandes de la 

vaina del individuo  
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El secado de las muestras se colocó en un secador del Laboratorio de Botánica Aplicada 

Jean-Christophe Pintaud donde permanecieron por un lapso de 3 días. Luego se procedió a 

preservarlo para enviarlo a un herbario. 

3.11.7 Modelo para predecir la distribución de Attalea moorei en el bosque 

estacionalmente seco del Huallaga. 

Los registros de coordenadas se obtuvieron de los 2 lugares de muestreo ( San Pedro de 

Cumbaza, provincia de San Martin y Pucacaca , provincia de Picota) con presencia de Attalea 

moorei , la distancia de un punto a otro punto fue de 50 m. El muestreo se realizó con un GPS 

Garmin Etrex 10 marcando donde hay abundancia de esta especie. Este procedimiento produjo 

50 puntos con coordenadas UTM que seguidamente se transformó a grados decimales para que 

el software Maxent que basado en un grupo de grillas o "rasters" georreferenciados con 

información de características ambientales, el modelo calculo la distribución de probabilidad 

donde cada celda tiene una idoniedad predictiva de condiciones para la especie.(Drake & Beier, 

2014). 

Maxent es uno método cuyo propósito general es caracterizar distribuciones de probabilidad 

cuya información está incompleta. Se basa en el principio de que la distribución estimada de 

una especie debe coincidir con la distribución conocida o deducida a partir de las condiciones 

ambientales dónde ha sido observada, evitando hacer cualquier suposición que no sea soportada 

por los datos. El enfoque consiste en encontrar la distribución de probabilidad de entropía 

máxima, que es la más cercana a la distribución uniforme, condicionada por las restricciones 

impuestas por la información disponible sobre la distribución observada de la especie y las 

condiciones ambientales del área de estudio. El método de Maxent no requiere datos de ausencia 

de la especie para elaborar el modelo; en vez de ello, usa los datos ambientales proporcionados 

por el área de estudio al completo como datos de pseudo-ausencia. 



58 

 

El método maxent no requiere datos de ausencia de la especie para elaborar el modelo; en 

vez de ello, usa datos ambientales propocionandos por el área de estudio. Puede usar variables 

continuas como categóricas, y el producto varia de 0 a 100 y se interpreta  en que medida un 

lugar es adecuado para que la especie se encuentre presente. 

El  modelo de para predecir la  distribución espacial se realizó utilizando el software Maxent 

es de código libre bajo licencia MIT. Maxent está programado en Java y tiene una Interfase 

Gráfica de Usuario para la importación de datos de registros y grillas de capas del medio 

físico.(Montoya, 2017) Teniendo el siguiente procedimiento según (Jimenez, 2017): 

1. Descarga de capas medioambientales 

Ingresara a la página de WORLDCLIM (http://www.worldclim.org/). 

Seleccionar la opción DOWNLOAD, verá que contiene información presente, 

del pasado (Holoceno Medio-6000 años, Ultimo Glacial Máximo-22000 años), y 

proyecciones a futuro. Para descargar capas bioclimáticas presentes seleccione la 

opción CURRENT→ ESRI grids → bioclimatic variables → bio 19s  

2. Elaboración de mapa y obtención de datos para cada punto de ocurrencia 

Definir la proyección a emplear. Se sugiere emplear la proyección WGS 1984 

UTM zone 18S, pero puede emplearse también la proyección WGS 1984. 

Coordinate System → Projected Coordinate System →UTM →Southern 

Hemisphere → WGS 1984 UTM. En la pestaña GENERAL, definir DECIMAL 

DEGREES. APLICAR → ACEPTAR. Se debe definir además las unidades a 

emplear, por ejemplo grados decimales; para esto seleccionar la pestaña 

GENERAL → Display → Decimal Degrees 

3. Añadir capas. Seleccionar la opción ADD DATA. 
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4. Para añadir puntos de ocurrencia se debe contar con un LIBRO DE EXCEL con 

la pestaña de trabajo nominada apropiadamente. En esta se tienen tres columnas, 

la primera contiene el nombre para cada especie de trabajo, la segunda 

corresponde a la latitud. 

5. Añadir este archivo de coordenadas y definir las columnas correspondientes a la 

longitud y la latitud. Para esto hacer click derecho sobre el archivo cargado → 

Display xy data… Y definir la columna correspondiente a la Longitud (X field) 

y Latitud (Y field). Los puntos aparecerán automáticamente sobre nuestro layer. 

6. Para observar en nuestro mapa los puntos de ocurrencia de acuerdo a alguna 

categoría hacer doble click sobre el archivo cargado de las coordenadas. 

Seleccionar la pestaña “Symbology” → Categories → Unique values → Value 

field. Luego elegir la opción que se requiera y dar click en “Add All Values…” 

→ Aplicar → Aceptar. 

7. Para extraer valores de cada variable medioambiental (layer) para cada punto de 

ocurrencia primero se debe transformar la Data → Export Data → asignar 

nombre y comprobar que la extension del archivo a generar sea “.shp”. Luego de 

haber cargado este nuevo archivo hacer click en la caja de herramientas, Arc 

Toolbox → Spatial Analyst Tools → Extraction → Extract. Multivalues to 

points. En la ventana mostrada arrastrar la información requerida. Los puntos de 

ocurrencia en “Input point features” y las capas medioambientales en “Input 

rasters”, luego “OK”. 

8. Para ver los datos extraidos dar click derecho sobre el shapefile de nuestas 

coordenadas → Open Attribute Table → Table Options → Export → Seleccionar 
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la opción con extensión “.txt”. Ahora este archivo en formato csv, puede abrirse 

en EXCEL. Modificar la separación por comas (,) o puntos y comas (;) asi como 

los signos para los decimales, según requiera su PC. Esto puede realizarse 

manualmente. 

9. Estos datos pueden someterse a un análisis de componentes principales, previa 

inspección de sus correlaciones lineales de a pares. Esto último puede realizarlo 

en R o en EXCEL. 

10. Preparación de los datos para Maxent 

Las capas medioambientales (shapefiles) necesitan ser transformadas en un 

formato tipo ASCII y en dimensiones establecidas por el usuario (delimitación). 

Se trabajará solo con variables no correlacionadas. Recuerda que esto último se 

realiza con la información brindada para cada punto de ocurrencia. 

11. Generar Polígono 

Para generar un polígono que delimite nuestros shapefiles a una determinada área 

de interés. Seguir las siguientes instrucciones: Click en Catalog → Seleccionar 

la carpeta donde se desee generar un nuevo shapefile → New → Shapefile → 

Asignar un nombre → Feature Type (POLYGON) → Unknown Coordinate 

System → Edit, seleccionar la proyección del sistema de coordenadas (WGS 

1984, en nuestro caso). Aparecerá el shapefile generado junto a los demás 

shapeflies con los que se está trabajando. 

12. Para definir la forma y extensión del polígono de trabajo dar click en Editor. Si 

no aparece esta opción por defecto, dar click en Customize → Toolbars → Editor. 

Editor → Start Editing → Seleccionar el Polígono → Editor → Editing Windows 
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→ Create Features → Seleccionar el Objeto → Construction Tools → Polygon 

→ Crear el objeto sobre el mapa → Editor → Stop Editing. Ya habrá creado un 

polígono para delimitar todos los shapefiles no correlacionados. 

13. Cortar los shapefiles con las dimensiones del polígono 

Seguir los siquientes pasos: ArcToolbox → Spatial Analyst Tools → Extraction 

→ Extract by Mask. Ingresar en “Input raster” la capa medioambiental y en 

“Input raster or feature mask data” el polígono trabajado. Proceder con todos los 

shapefiles. 

14. Asignar a todos los shapefiles las mismas resoluciones. 

Sequir las instrucciones siguientes: Geoprocessing → Environments → Extender 

las opciones siguientes: “Output Coordinates”, “Processing Extent” y “Raster 

Analysis”. En la primera opción “Output Coordinates” seleccionar el sistema de 

coordenadas con el que se ha trabajado desde el inicio, en nuestro caso WGS 

1984. 

15. Convertir los shapefiles a formato ASCII 

ArcToolbox → Conversion Tools → From Raster → Raster to ASCII. Ingresar 

los shapefiles modificados (RASTERS) en la opción Input y en Output 

seleccionar una carpeta de salida. Además deberá cambiar la extensión del 

archivo como “.ASC”, esto es muy importante y deberán modificarse las 

extensiones dos veces, tanto en la opción output como en la carpeta “GUARDAR 

COMO”. 

16. Finalmente, genere un archivo “.CSV” con el archivo de coordenadas en EXCEL. 

Recuerde que un archivo .CSV convencional contiene el símbolo “,” para separar 
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columnas y “.” para los decimales. Si EXCEL no genera el archivo con estos 

requisitos, modifíquelo en un editor de texto como BLOC DE NOTAS. 

17. Empleo de MAXENT 

Maxent requiere de un archivo en formato “.CSV” (que contiene las coordenadas 

geográficas y especies cuyas distribuciones potenciales se desean conocer) y 

shapefiles en formato “.ASC”, los mismos que corresponden a las variables. Para 

cargar esta información siga las siguientes rutas: 

Samples → Browse → elija el file 

Environmental layers → Browse → elija las capas en formato “.ASC” 

No olvide que debe indicar a MAXENT si se trata de variables continuas o 

categóricas. 

 

 

 

 

 

 

 

 

 

 
                           Fuente: (Jimenez Vasquez, 2017) 

  

18. Seleccione los features o emplee la opción Auto features para que MAXENT 

determine las combinaciones más apropiadas, esto en la esquina inferior 
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izquierda. Recuerde que los features son las transformaciones (muchas de ellas 

no lineales) que se realizan sobre las variables (covariates) iniciales. 

19.  Seleccione las opciones Create response curves, Make pictures of predictions y 

Do jackknife to measure variable importance para identificar los rangos de 

distribución asociado a cada variable, obtener gráficas y realizar un test de 

importancia para cada variable, respectivamente. 

20. Seleccione el tipo de output (Output format), el cual se presenta en cuatro tipos, 

de los cuales Logistic y Raw ofrecen probabilidades de ocurrencia según 

enfoques compatibles y el tipo de file del output (Output file type), de preferencia 

seleccione el tipo “.ASC”. Indique también la carpeta de salida Output directory 

→ Browse. 

21. Para modificar los parámetros por defecto de MAXENT haga click en Settings. 

Aparecerá una nueva ventana con tres pestañas Basic, Advanced y Experimental. 

Estas nos servirán para configurar el porcentaje de datos para test y train, la 

metodología para elegir estos datos, el número de réplicas, etc. 

22. Algunas opciones deberán ser seleccionadas y modificadas en la pestaña Basic, 

como Random seed, seleccione para indicar a MAXENT que se emplearán datos 

de test y train Random test percentage, para indicar a MAXENT que se empleará 

un determinado porcentaje para las evaluaciones y un porcentaje para el modelo 

en sí. Replicates, para indicar el número de réplicas a realizar, si indica un número 

determinado, MAXENT estimará un promedio de estos al final de sus cálculos. 

Replicate run type, para indicar la metodología de selección de los datos de cada 

réplica. 
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23. En la pestaña Advanced, puede modificar los números de iteraciones (Maximum 

iterations) desde 500 hasta valores mayores, por ejemplo 5000. Esto indica a 

MAXENT cuantas veces debe seleccionar como máximo los datos para cada 

corrida. Tenga mucho cuidado con la opción Default prevalence, lo que está 

relacionado con el valor de τ. MAXENT considera un valor de 0.5 por defecto 

24. Outputs de MAXENT 

MAXENT genera muchos archivos de salida, como los siguientes: 

25. Archivos de valores separados por comas (.CSV). Hay tres archivos de este tipo 

Predictions (que indica las probabilidades de ocurrencia de cada punto de 

muestreo ingresado como dato), Averages (indica los promedios de los valores 

de cada variable con los que se obtienen mayores probabilidades de ocurrencia) 

y Omission (compara resultados del modelo vs. el azar). 

26. Archivos “.ASC”, que muestran cada modelo estimado (correspondiente con el 

número de réplicas indicadas en MAXENT), stddev (desviación estándar de la 

predicción), min (valores mínimos de la predicción), median (datos de media de 

la predicción), max (valores máximos de la predicción), avg (el promedio de 

todas las réplicas realizadas). 

27. Archivos “.HTML”, que resumen de manera gráfica las estimaciones realizadas, 

arrastre estos archivos hacia una ventana del explorador para conocer 

→ Gráficas de Omission / Commission, en las cuales podemos observar de 

manera general cómo nuestros datos de desvían de las predicciones y del azar. 

28. La primera grafica indica una línea predictiva (en negro) de falsos negativos, y 

nuestros datos estimados por el modelo (en celeste y naranja). La segunda gráfica 
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(Sensitivity vs 1 –Specificity) es la Area Under the Receiver Operating 

Characteristic (ROC) Curve o simplemente AUC. Un valor de AUC de 0.5 indica 

que el modelo no es mejor que el azar, mientras que valores cercanos a 1, indican 

lo contrario, un buen performance del modelo. 

29. Imágenes del modelo estimado. Puede corresponder a cada replica o al promedio, 

en cuyo caso se muestra también la desviación estándar. 

30. Curvas de respuesta (Response Curves) 

Las cuales se presentan en dos grupos, el primero indica como varían las 

predicciones cuando todas las variables se mantienen en sus promedios y solo 

una de ellas varía, en cada uno de los casos. 

31. Análisis de la contribuciones de cada variable (Analysis of variable 

contributions), se resume en una tabla la importancia de cada variable (Percent 

contribution). 

32. Y las siguientes tablas indican la importancia de cada variable en función del 

gain, obtenido mediante la prueba de Jackknife, cuando se suprimen (Without 

variable) o cuando solo se considera cada variable (With only variable) tanto para 

los datos de training como para los datos de test. 

33. Los mapas generados por MAXENT, pueden ser cargados en ArcGIS para 

su posterior modificación. Se ha generado mapas en formatos ASC. I) 

Proyección 

34. Es necesario asignar una proyección al mapa generado. Para ello seguir la 

siguiente ruta: ArcToolBox → Data Management Tools → Projections and 

Transformations → Raster → Define Projection. 
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35. Transformación del mapa 

Para modificaciones posteriores el mapa puede ser transformado en un RASTER. 

Para ello seguir los siguientes pasos: ArcToolBox → Conversion Tools → To 

Raster → ASCII to Raster. 

36. Modificar la escala de probabilidad de ocurrencia del mapa ArcToolBox → 

Spatial Analyst Tools → Map Algebra → Raster Calculator 

37. Arrastre el RASTER de interés y divida entre el valor superior.  Ahora está usted 

listo para modificar la escala de colores a su gusto. 

 

 

 

 

 

 

 

 

 

Fuente: (Jimenez, 2017) 

Tabla 5.  

Descripción de las variables climáticas utilizadas en los modelos de distribución potencial 

obtenidas de World Clim  

Variable Descripcion 

  

BIO2 

 

 Rango diurno medio (Media mensual (temperatura máxima 

- temperatura mínima)) 

BIO3 Isotermalidad (BIO2 / BIO7) (× 100) 
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BIO4 Estacionalidad de temperatura (desviación estándar * 100) 

BIO5 Temperatura máxima del mes más cálido 

Fuente: (Worldclim, 2017) 

Los patrones de distribución fue de manera aleatoria ya que los individuos están al azar sin un 

patrón predecible, las semillas de Attaleas se propagan por grandes extensiones y germinan donde 

caen, es por eso que en cualquier parte de la región San Martin siempre habrá Shapaja ya que son 

indicadores de suelos secos e intervenidos por el hombre. 

3.11.8 Evaluación del suelo  

Las evaluaciones del suelo de los dos lugares de estudio se realizaron mediante 

observaciones del terreno donde se establecieron las parcelas. Para las manchas se utilizó la 

clave de estimación de cobertura de fragmentos gruesos y moteados expresado en porcentajes 

donde escasos <2 %, comunes >2%, <20 % y abundantes >20% (Munsell Soil Color Charts, 

2009). Para hacer las descripciones del suelo se procedió a realizar los siguientes pasos: 

 

 

 

  

 

 

 

 

 

Figura 7. Clave de estimación de fragmentos gruesos y moteados  

En la parcela 1 (San Pedro de Cumbaza), se estableció una calicata en cada una de las zonas 

seleccionadas, de las cuales se anotaron las características físicas como: textura, color y 

presencia o ausencia de manchas. La calicata tuvo las siguientes dimensiones: 1 m de ancho x 

1 m de largo x 70 cm de profundidad. El perfil del suelo presenta una capa orgánica de 

Abundancia de 

fragmentos:  

-Escasos (<2 %) 

-Comunes (>2%, 

<20%) 

-Abundantes (> 

20%) 
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hojarasca, seguida del suelo dividido por capas A y B. La capa A después de la hojarasca, tuvo 

una medida de 15 cm donde se anotó la textura y color. La capa B esta después de la capa A, 

tuvo como medida 55 cm, del mismo se anotó la textura y color. También se apuntó las 

coordenadas del lugar de estudio. Para la caracterización del suelo se llevó la muestra al 

Instituto de Cultivos Tropicales la cual realizo el análisis respectivo. 

En la parcela 2 Pucacaca (Ojos de agua), se estableció una calicata en cada una de las zonas 

seleccionadas, de las cuales se anotaron las características físicas como: textura, color y 

presencia o ausencia de manchas. La calicata tuvo las siguientes dimensiones: 1 m de ancho x 

1 m de largo x 70 cm de profundidad. El perfil del suelo presenta una capa orgánica de 

hojarasca, seguida del suelo dividido por capas B y D. La capa A después de la hojarasca, tuvo 

una medida de 15 cm donde se anotó la textura y color. La capa D esta después de la capa B, 

tuvo como medida 55 cm, del mismo modo se anotó la textura y color. También se apuntó las 

coordenadas del lugar de estudio. Para la caracterización del suelo se llevó la muestra al 

Instituto de Cultivos Tropicales la cual realizo el análisis respectivo. 
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CAPITULO IV. 

RESULTADOS Y DISCUSION 

 

4.1 Resultados  

Estructura Poblacional de Attalea moorei  

La estructura poblacional está representada por medio de categorías de crecimiento, la 

categoría I abarca (0 hasta < 3 m), categoría II (3 m hasta < 14 m), categoría III (15 m hasta < 

19 m) y categoría IV (20 m hasta > 30 m). 

Tabla 6.  

Tabla de Frecuencia para San Pedro de Cumbaza 

 

 

 

 

 

 
                 

        Fuente: Elaboración propia 2019 

 

La tabla 6 contiene el número de individuos por categorías de crecimiento de Attalea moorei 

y el porcentaje por cada uno. En Categoria I 1219 (78.6%), Categoria II 271 (17.5 %), Categoria 

III 27 (1.7 %) y Categoria 32 IV (2.1 %). 

Tabla 7.   

Tabla de Frecuencia para Pucacaca 

 

       

 

Fuente: Elaboración propia 2019 

Categorias n % 

  I (0 hasta < 3 m) 1219 78.6 

II ( 3 m hasta < 14 m) 272 17.5 

III  (15 m hasta < 19 m) 27 1.7 

IV (20 m hasta ≤ 30 m) 32 2.1 

Total 1550 100 

Categorias n % 

I 900 73.8 

II 218 17.9 
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En la tabla 7 se encuentra el 

número de individuos por 

categorías de crecimiento de 

Attalea moorei y el porcentaje por cada uno. En Categoria I 900 (73.8%), Categoria II 218 (17.9 

%), Categoria III 52 (4.3 %) y Categoria IV 50 (4.1 %). 

Tabla 8.  

 Tabla de Frecuencia para ambas localidades  

 

 

 

 

 

 
 

 

 

Fuente: Elaboración propia 2019 

 

           En la tabla 8 se detalla el resumen de frecuencias de ambas localidades. 

 

 

 

 

 

 

 

 

 

 

Figura 8. Composición porcentual de individuos de Attalea moorei en las dos parcelas del bosque 

estacionalmente seco del Huallaga, San Martin- Perú. 

 

III 52 4.3 

IV 50 4.1 

Total  1220 100 
C

at
eg

o
ri

as
  

  Cumbaza  Pucacaca 

I 1219 900 

II 272 218 

III 27 52 

IV 32 50 
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La figura 7 representa un gráfico de barras donde indica el porcentaje de individuos por cada 

categoría de crecimiento (I, II, III, IV) en ambas localidades. En San Pedro de Cumbaza 

tenemos para Categoria I Categoria I 78.6%, Categoria II 17.5%, Categoria III 1.7% y Categoria 

IV 2.1%. En Pucacaca tenemos para Categoria I 73.8%, Categoria II 17.9%, Categoria III 4.3% 

y Categoria IV 4.1%. 

Como los datos no presentan una distribucion normal se utilizo la prueba no parametrica de 

Kruskal-Wallis de doble via , porque estan interviniendo dos factores que es  localidad y 

categoria de crecimiento,  a continuacion se presenta una tabla descriptiva en las cuales detalla 

los resultados obtenidos con la variable altura  y los dos lugares de estudio por cada categoria de 

crecimiento. 

Tabla 9.  

Tabla de descriptiva  para ambas localidades  

 

Varia

ble 
Localidad Categoría x̄ + DS Rango 

CV 

(%) 
Normalidad 

Homocedas

ticidad 

Kruskal-

Wallis 

Altura 

total 

San 

Pedro de 

Cumbaza 

I 99,88 ± 66,18 10 – 380 66,25 2,2e-16  (***) 2,2e-16(***) 
Categoría 

I 

II 599,23 ± 292,85 100 – 1800 48,87 2,2e-16 (***) 0,0268(*) 2,2e-16  

III 1690,00 ± 227,07 1200 – 2200 13,49 6,2e-07(***) 0,9693 
Categoría 

II 

IV 2729,03 ± 283,07 2100 – 3000 10,37 3,72e-07(***) 0,2063 0,003776 

Pucacaca 

I 69,19 ± 61,05 10 – 680 88,23 2,2e-16(***) 2,2e-16 (***) 
Categoría 

III 

II 653,91 ± 276,73 180 – 1500 42,32 2,2e-16(***) 0,3119 0,001867 

III 1850,98 ± 188,01 1500 – 2600 10,16 2,2e-16(***) 0,1395 
Categoría 

IV 

IV 2926,53 ± 322,60 2000 – 3000 11,02 2,2e-16(***) 0,7954 0,001563 

Fuente: Elaboración propia 2020 

Leyenda: x̄ = media; DS = desviación estándar; R = rango; CV = coeficiente de variación; Significancia: (***) = p < 

0,001; (**) = p < 0,01; (*) = p < 0,05. 
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La tabla 9 presenta la variable altura total en las dos localidades y las categorias de crecimiento, 

cada una con un promedio y desviacion estandar de su altura por categoria, asi mismo un rango de 

alturas desde Categoria I, II,III  y IV. Como vemos los datos no son normales, asi que se procedio 

a utilizar la  prueba no parametrica de Kruskal- Wallis y alli se muestran que para las Categorias 

I,II,III y IV el valor de p se encuentran por debajo de la significancia p < 0,05. Para Categoria I si 

existe diferencia, igualmente para II,III y IV. 

Entonces de acuerdo a nuestra hipotesis de investigacion se acepta la H1 encontrandose diferencias 

significativas entre ambas localidades porque el valor de p es menor de 0,05.  

 

Figura 9. Categorias de crecimiento y lugares de muestreo 

La figura 9 representa las categorías de crecimiento y las dos localidades de muestreo. Entre 

ambas localidades, San Pedro de Cumbaza es la que presenta mayor número de individuos para 

la Categoría I y II. Mientras que Pucacaca presenta la mayor cantidad de individuos en las 

categorías III Y IV. Esto se debe que en San Pedro de Cumbaza hay más regeneración siendo 

esto un indicador de la viabilidad biológica de la planta. 
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 Figura 10. Curva J invertida para ambas parcelas de estudio  

En la figura 10 se observa la distribucion de las categorias de crecimiento a manera de J 

invertida en San Pedro de Cumbaza y Pucacaca, esto nos indica que el indice de regeneración 

en ambos lugares es constante, tambien refleja el buen estado regenerativo de la poblacional 

actual. 

Modelo para predecir la distribución de  Attalea moorei en las dos parcelas  

 

Figura 11. Análisis de omisión para Attalea moorei 
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En esta figura se muestra la tasa de omisión de prueba y el área pronosticada en función del 

umbral acumulativo, promediado sobre las ejecuciones repetidas, la tasa de omisión y el área 

pronosticada en función del umbral acumulativo, promediado sobre las repeticiones y vemos que 

la omisión sobre las muestras de prueba se ajusta muy bien a la omisión estimada. La tasa de 

omisión estimada es la línea recta, que está definida por el formato de salida, esto quiere decir que 

los datos de prueba son independientes y provienen de distintos datos de presencia espacialmente. 

 

Figura 12. Curva de característica de funcionamiento del receptor (ROC) y AUC correspondientes 

En esta figura se muestra la curva de característica de funcionamiento del receptor (ROC) para 

los mismos datos, nuevamente promediada sobre las ejecuciones repetidas. El AUC de 

entrenamiento promedio para las repeticiones es de 0.8243 y la desviación estándar es de 0.019. 

La línea azul y roja son idénticas ya que se usan los mismos datos para el entrenamiento y para la 

prueba. La línea negra muestra lo que espera el modelo del azar.  

De acuerdo con (Araújo & Guisan, 2006), muestra una guia general para la clasificacion de 

modelos en función al AUC : 0.5-0.6 insuficiente; 0.6-0.7 pobre; 0.7-0.8 promedio; 0.8-0.9 bueno; 

0.9-1 excelente. La eficiencia de predicción del modelo muestra un valor de AUC 0.824, 

encontrandose dentro del intervalo con una buena capacidad predictiva. 
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Figura 13. Promedio de las 4 variables climáticas para Attalea moorei. 

En la figura se encuentra el promedio de las 4 variables climáticas para Attalea moorei, usando 

los colores para indicar la probabilidad de condiciones adecuadas; el rojo indica una alta 

probabilidad de condiciones adecuada para la especie, verde indica las condiciones representativas 

de aquellos lugares donde la especie se encuentra, y celeste indican una baja probabilidad de 

condiciones adecuadas. Para Attalea moorei, vemos que las condiciones adecuadas como 

altamente probables abarca la mayor parte en la provincia  Picota y San Martin se encuentra dentro 

del color celeste indicando una baja probabilidad. 

  Figura 14. Curvas de respuesta para cada variable ambiental (bio2 Rango diurno medio (Media mensual 

(temperatura máxima - temperatura mínima), bio3 Isotermalidad (BIO2 / BIO7) (× 100),  bio4 Temporalidad de la 

temperatura (desviación estándar * 100) y bio 5 Temperatura máxima del mes más cálido. 
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Las curvas muestran cómo cambia la probabilidad de presencia que un individuo ocupe ese 

rango de la variable ambiental, manteniendo todas las demás variables ambientales en su valor de 

muestra promedio. Para bio2 la mayor probabilidad de encontrar a los individuos es 12.183, bio 3 

89.01, bio 4 46.73 y  bio 5 33.6. Los valores mostrados en el eje de las “y” es la probabilidad 

estimada en condiciones favorables en localización de presencias.   

Tabla 10.   

Análisis de contribuciones de las variables ambientales  

Variable Contribución 

porcentual (%) 

Bio3 50 

Bio2 50 

Bio5 0.0 

Bio4 0.0 

Fuente: Elaboración propia 2019 

 
(bio2 Rango diurno medio (Media mensual (temperatura máxima - temperatura mínima), bio3 Isotermalidad (BIO2 / 

BIO7) (× 100),  bio4 Temporalidad de la temperatura (desviación estándar * 100) y bio 5 Temperatura máxima del 

mes más cálido. 

 

La tabla muestra los valores de contribución porcentual de las variables ambientales al modelo 

de Maxent. La variable que más porcentaje contribuye es bio3(Rango diurno medio) con 50% y 

bio2(Isotermalidad) con 50%,  variables medio ambiental del cual dependería la distribución de 

Attalea moorei en el rango de temperatura de 22°C a 26° C en la región San Martin. 

 
Figura 15. Prueba de Jackknife ganancia de entrenamiento regularizado para Attalea moorei 
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La variable ambiental con mayor ganancia cuando se usa de forma aislada es bio2, que por lo 

tanto parece tener la información más útil por sí misma. La variable ambiental que disminuye más 

la ganancia cuando se omite es bio2, que por lo tanto parece tener la mayor cantidad de información 

que no está presente en las otras variables.  

Figura 16. Prueba de Jackknife correspondiente al AUC para Attalea moorei 

La figura muestra que Bio2 es la variable que mejor predice por si sola la distribución de los 

datos que se usaron como prueba. 

 
Figura 17. Variables ambientales y rangos de probabilidad de presencia de la especie Attalea moorei  
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Figura 18. Mapa de distribución potencial de Attalea moorei San Pedro de Cumbaza ( Provincia de San Martin) 

y Pucacaca ( Provincia de Picota) 

  

La figura 18 presenta tres colores que determinan la probabilidad de distribución de la especie 

Attalea moorei en las 2 provincias pertenecientes al área de estudio,  se muestrearon 50 puntos de 

distribución en San Pedro de Cumbaza y Pucacaca. El porcentaje de probabilidad alto es de color 

rojo y abarca desde 41 a 70 % en las cuales se encuentran los mayores puntos de distribución en 

la provincia de Picota. El porcentaje de probabilidad medio es de color amarillo y abarca desde 15 

a 41 % y abarca pocos puntos de distribución. El porcentaje de probabilidad bajo es de color verde 

esto indica que existe la especie, pero en menor cantidad en ambos lugares. 

Caracterización del suelo en San Pedro de Cumbaza y Pucacaca  

En San Pedro de Cumbaza existen suelos bien drenados con relieve plano, el suelo presenta una 

textura arcillosa, con pH 7.34 ligeramente alcalino, conductividad eléctrica >0.3 dS/m, materia 

orgánica 0.73 clasificación bajo, fosforo (P) 3.30 ppm clasificación bajo, potasio (K) 238 ppm 

clasificación medio. El perfil del suelo se encuentra caracterizado por presentar una capa en 

superficial, seguida de dos capas A y B. La capa superficial tiene un espesor de 4 cm de espesor 

Modelo de predicción de distribución de la especie Attalea moorei en las dos parcelas de 

las Provincias Picota y San Martin 
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lo cual se encuentra compuesto por hojarasca, ramas caídas de los árboles, raíces. La capa A mide 

40 cm de profundidad, el color del matiz es 2.5Y 8/6 Yellow, las manchas que abundan son del 

tipo común con 5%. La capa B mide 30 cm de espesor se observa raíces muy adheridas al suelo, 

el color del matiz es 5Y 8/6 Yellow, las manchas que sobresalen son del tipo abundante con 25%. 

 

Figura 19. Perfil del suelo del lugar de estudio del distrito de San Pedro de Cumbaza 

 

En Pucacaca (Ojos de agua) existen suelos inundables con deficiente drenaje, el suelo presenta 

una textura franco-arenosa con pH 7.51 ligeramente alcalino, conductividad eléctrica >0.25 dS/m, 

materia orgánica 2% clasificación media, fosforo (P) 2.31 ppm clasificación bajo, potasio (K) 220 

ppm clasificación medio. El perfil del suelo se encuentra caracterizado por presentar una capa en 

superficial, seguida de dos capas A y B. La capa superficial tiene un espesor de 1 cm de espesor 

lo cual se encuentra compuesto por hojarasca, ramas caídas de los árboles, raíces. La capa B mide 

20 cm de profundidad, el color del matiz es 10YR 4/2 marrón grisáceo oscuro, las manchas que 

abundan son del tipo común con 3%. La capa A mide 50 cm de espesor, también se observa raíces 

muy adheridas al suelo, el color del matiz es 10YR 6/3 marrón pálido, las manchas que sobresalen 

son del tipo común con 3%. 

 

Hojarasca (4 cm)  

Capa B (40-70cm)  

Capa A (0-40cm)  
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Figura 20. Perfil del suelo del lugar de estudio del distrito de Pucacaca (Ojos de agua) 

 

Caracterización morfológica de Attalea moorei (Shapaja) en dos parcelas del bosque 

estacionalmente seco del Huallaga 

En base a los registros obtenidos que servirán para extender los conocimientos sobre la especie 

de interés y sus partes, se detallan a continuación: 

 San Pedro de Cumbaza  

Palmera monocaule, Altura total 15 m, Tallo hasta 2 m de alto, con 38 cm de diámetro; 

El limbo de las Hojas es ancho en la base y muy angosto en el ápice, Largo de la hoja hasta 

990 cm, número total de hojas es de 15, en la parte apical los segmentos (foliolos) están 

parcialmente unidos (se estima 5 por lado) formando una culminación semi-entera en 

forma de abanico; Largo de vaina y peciolo es de  60 cm, el ancho en su base es 25 cm, el 

aspecto de las fibras es compacto y están dispuestas longitudinalmente en los bordes, el 

color en la parte Adaxial es verde, donde se describe su indumento como escamas de color 

beige y en la parte Abaxial verde claro glauco, no presenta indumento (glabro); Largo del 

Hojarasca: 1 cm de 

espesor  

Capa B (50-70 cm) 

Capa A (0-50 cm) 
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raquis 990 cm, el color del raquis de la hoja en la parte Adaxial es verde oscuro y en la 

parte Abaxial verde claro glauco, el indumento Adaxial es escamoso y en la parte Abaxial 

es glabro; Numero de pinnas es de 349 de forma lanceolada y rígidas, distribuidos de forma 

equitativa por cada lado del raquis (derecha e izquierda, respectivamente), no agrupados y 

dispuestos en un solo plano, el indumento de la lámina Abaxial es glauco, presenta 

nervaduras glabras con forma de triángulo acanalado en la parte Adaxial y glaucas-

acanaladas en la parte Abaxial, las pinnas  ubicados en la parte basal tienen un largo y 

ancho promedio de 95 cm y 1 cm, respectivamente, las pinnas ubicados en la parte media 

tienen un largo y ancho promedio de 130 cm y 2 cm, respectivamente, las pinnas ubicados 

en la parte apical tienen un largo  y ancho promedio de 70 cm y 1 cm, respectivamente. 

 

 Pucacaca (ABOFOA Ojos de agua)  

Palmera monocaule, Altura total 13 m, Tallo hasta 1.5 m de alto, siendo el diámetro 

promedio 1.60 cm. El color de su superficie tierna es grisáceo, mientras que el color de la 

superficie vetusta es marrón-beige. El patrón y textura de la superficie es áspera-escamosa, 

el aspecto de los remanentes de las hojas es convexo-abultado. El limbo de las Hojas es 

ancho en la base y muy angosto en el ápice, Largo de la hoja 1260 cm, el número total de 

hojas es de 12; en la parte apical los segmentos (foliolos) están parcialmente unidos (se 

estima 8 por lado) formando una culminación semi-entera en forma de abanico; Largo de 

la vaina y peciolo es de 70 cm; el ancho en su base es 20 cm, el aspecto de las fibras es 

compacto y están dispuestas longitudinalmente en los bordes. El color en la parte Adaxial 

es verde, donde se describe su indumento como escamas de color beige y en la parte 

Abaxial verde claro glauco, no presenta indumento (glabro); Largo del raquis 1260 cm, el 

color del raquis de la hoja en la parte Adaxial es verde oscuro y en la parte Abaxial verde 

claro glauco, el indumento Adaxial es escamoso y en la parte Abaxial es glabro; Numero 

de pinnas es de 442 de forma lanceolada y rígidas, distribuidos de forma equitativa por 

cada lado del raquis (derecha e izquierda, respectivamente), no agrupados y dispuestos en 

un solo plano, el indumento de la lámina Abaxial es glauco, presenta nervaduras glabras 

con forma de triángulo acanalado en la parte Adaxial y glaucas-acanaladas en la parte 

Abaxial, las pinnas  ubicados en la parte basal tienen un largo y ancho promedio de 65 cm 

y 1 cm, respectivamente, las pinnas ubicados en la parte media tienen un largo y ancho 
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promedio de 100 cm y 2 cm, respectivamente, las pinnas ubicados en la parte apical tienen 

un largo  y ancho promedio de 50 cm y 1 cm, respectivamente. 

Plántulas. - La forma de la lámina del eófilo es lanceolada y de color verde intenso. 

Ausencia de indumento en la lámina y la forma de su punta es primorsa. No presenta 

indumento en la última hoja no-dividida, tampoco peciolo y vaina. 

 

4.2 DISCUSION 

Las poblaciones de Attalea moorei de San Pedro de Cumbaza y Pucacaca se encuentran dentro 

de los bosques estacionalmente secos de la región San Martin las cuales presentan diferencias entre 

sí en las alturas por cada categoría de crecimiento. Del mismo modo el habitad donde se encuentran 

las poblaciones está compuesta por características ecológicas. La adaptación de las especies y la 

composición de las comunidades vegetales en los distintos tipos de bosques son resultado de una 

combinación de factores como el origen, la dinámica y composición de los suelos, la calidad del 

agua y los regímenes de lluvia (Biodamaz, 2004). El conocimiento de la distribución de una 

especie puede dar una idea acerca del comportamiento de la población y permite realizar respuestas 

acerca de cómo puede ir cambiando a través del tiempo y frente a distintas prácticas de manejo 

(Galeano et al., 2008) 

Estructura poblacional de Attalea moorei (Shapaja) en dos parcelas del bosque 

estacionalmente seco del Huallaga 

La estructura poblacional de Attalea moorei en San Pedro de Cumbaza y Pucacaca fueron 

evaluados en 2 subparcelas de 20 x 20 por medio de Categorias I, II, III y IV que permitieron 

diferenciar estas dos poblaciones (Tabla 3), dentro de las cuales se registró 1250 individuos para 

San Pedro de Cumbaza y 1220 para Pucacaca. Las diferencias se registraron por cada estadio de 

desarrollo, para San pedro de Cumbaza la Categoria I fueron 1219, Categoria II 271, Categoria III 

27 y Categoria IV 32 (Tabla 6). Pucacaca para Categoria I fueron 900, Categoria II 218, Categoria 

III 52 y Categoria IV 50 (Tabla 7). La definición de las categorías de crecimiento de la especie en 

estudio se realizó de acuerdo a la recomendación de Henrik Balslev (Balslev, 2010)  donde 

recomienda que las categorías de edad de las palmas corresponden a plántulas, juveniles, pre-

adultos y adultos, dicha referencia,  la observación in-situ y algunos criterios morfológicos 
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discutidos por parte del equipo técnico del proyecto en 2014, fueron la base para definir las 

categorías de crecimiento. 

De acuerdo con los resultados obtenidos podemos decir que si existe diferencia significativa 

entre la estructura poblacional y las dos parcelas del bosque estacionalmente del Huallaga. Con la 

variable altura (cm) para categoría I el promedio es de 190 individuos con la mayor altura de 40 

cm  en la población de Pucacaca , el promedio es de 160 individuos con la mayor altura de 40 cm 

para San Pedro de Cumbaza , Categoria II es de 30 individuos con mayor altura de 600 a 650 cm 

en Pucacaca, el promedio corresponde a 38 individuos con la mayor altura de 300 y 500 cm para  

San Pedro de Cumbaza, Categoria III el promedio es de 15 individuos con mayor altura de 1800 y 

2000 cm  para Pucacaca, el promedio corresponde a 8 individuos con mayor altura de 1800 cm en 

San Pedro de Cumbaza y Categoria IV  el promedio es de 18 individuos con la mayor altura de 

3000 cm en Pucacaca y el promedio corresponde a 10 individuos con la mayor altura de 3000 cm 

en San Pedro de Cumbaza, el cual nos permito tener diferencias de alturas de Attalea moorei en 

ambas poblaciones. (Macedo, 2015) describió la caracterización morfológica y estructura 

poblacional  de Attalea huebneri en trece subparcelas de 20 x 20 en la zona de estudio de Jenaro 

Herrera que hacen un total de 0,52 ha, la cual se registraron un total 209 individuos, de los cuales 

14 individuos estuvieron en la categoría de IV, 6 juveniles III, 100 juveniles II y 89 juveniles I. En 

cinco subparcelas de 20 x 20 (0,2 ha) se registraron 164 plántulas. Para la zona de estudio de 

Bagazán trece subparcelas de 20 x 20 m, que resulta un total de 0,52 ha, se registraron 64 

individuos, de los cuales 29 fueron IV, 29 juveniles III, 2 juveniles II y 4 juveniles I. No se 

observaron individuos en la categoría de plántulas. Los individuos de desarrollo adulto y juvenil 

III permitió medir caracteres vegetativos,  encontrándose diferencias significativas en las dos 

poblaciones de Attalea, llegando a medir hasta 50.9 cm en las poblaciones de Bagazan y 48 cm en 

Jenarro Herrera. 

También (Machagua, 2012) describe la estructura poblacional de dos especies Astrocaryum 

chonta y Astrocaryum Javarense donde la mayor cantidad de individuos se  encuentran entre 

plántulas 1270 para bosque estéreo, 1220 para shapajal y juveniles I 790 para bosque de estéreo,  

1270 para shapajal. Pocos de ellos llegan a alcanzar al estado de Juvenil II 50 para bosque de 

estéreo, 25 para shapajal y adulto 80 para Estereo, 50 shapajal, debido a una alta mortalidad en 

Juveniles I y plántulas por parte de los herbívoros o por la escaza luz que ingresa en el sotobosque 
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como fue registrado en trabajos anteriores con otras especies de palmeras y en el género 

Astrocaryum (Kahn & Granville, 1992). Para bosque de fierrocaño 210 para plántula , 131 juvenil 

I, 15 juvenil II y 50 para adulto. Bosque copal 230 para plántula, 182 juvenil I, 18 juvenil II y 58 

adulto. 

La estructura poblacional nos permite conocer la viabilidad biológica y los niveles de 

regeneración de la especie en determinadas categorías de crecimiento (I plántula, II juvenil , III 

subadulto, IV adulto) (Moraes, Vargas, Miguez, & Sardán, 2014). Los resultados obtenidos tienen 

evidencia de caracteres vegetativos (Hojas, frutos) las cuales permiten identificar a la especie 

Attalea moorei, del mismo modo nos permite conocer el estado de conservación y desarrollo en 

las dos localidades de estudio. 

Según (Moraes et al., 2016), evaluó la estructura poblacional de cinco especies de palmeras 

útiles, presentando estructuración en forma de J invertida, lo que indica que estas especies 

presentan condiciones naturales favorables para su manejo en las zonas evaluadas, puesto que sus 

patrones poblacionales garantizan una permanente regeneración y consiguiente  sostenibilidad. 

(Jácome, 2013) en sus resultados de estructura poblacional para Phytelephas aequatorialis 

(tagua) menciona que hizo las evaluaciones en dos bosques de muestreo, el primero es Canuto ( 

pastizal) donde la población se compone de 149 individuos , de los cuales 30 son juveniles I, 45 

adultos 2 , 23 adultos 3, la tercera parte de la población corresponde plántulas; a pesar de esto, es 

probable que estos individuos únicamente alcancen el estadío de juvenil 1 esto se debe a que fueron 

cortados junto a la maleza para la siembra de pasto.  El segundo es Junín (Bosque secundario en 

recuperación) en donde la población está compuesta de 2704 individuos, para juvenil I 1022, en 

cuanto a las categorías de adultez los individuos pertenecen mayoritariamente a A2,a pesar de ser 

una población más estable que la de Canuto no cuenta con todos los estadíos de crecimiento. La 

escasez de estadíos de adultez es marcada, únicamente se encontraron individuos de las clases A2 

y A3, no cuenta con todos los estadíos de crecimiento. Debido a que la población se encuentra en 

recuperación hace una década, no se observan individuos con hábito en roseta con altura >3 m, a 

excepción de uno perteneciente a la categoría J6, con altura de ~5 m y todavía sin tronco. Hay una 

alta proporción de juveniles 1, en comparación con otros estadíos. A partir de esta categoría la 

cantidad de individuos comienza a decrecer conforme avanza el estadío; esta conformación de J 

invertida en P. aequatorialis ha sido observada también por (Velásquez-Runk,1998), tanto en 
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ambientes naturales como disturbados, con la diferencia de que en ambientes disturbados la 

cantidad de subadulto fue mínima o nula. 

 

Modelo de distribución  de Attalea moorei en el bosque estacionalmente seco del Huallaga, 

región San Martin  

Se registraron 50 puntos de Attalea moorei en los dos lugares de muestreo San Pedro de 

Cumbaza ( Provincia de San Martin ) y Pucacaca ( Provincia de Picota), la distribución de punto 

a punto fue de 50 m. Según el mapa de probabilidad de presencia de la especie la distribución alta 

(rojo) de Attalea moorei comprende desde 41 a 70 % ubicándose en este rango las provincia de 

Picota, la probabilidad de distribución media (amarillo) esta desde 15 a 41 % abarcando una parte  

Picota y San Martin (Tarapoto), la probabilidad de presencia baja (verde) esta desde 15 a 0.00 % 

y se encuentra  la especie en menores cantidades. La variable ambiental con mayor ganancia 

cuando se usa de forma aislada es bio2 ( rango diurno medio (temperatura máxima - temperatura 

mínima)) por lo tanto parece tener la información mas útil por si misma. 

Según (Reguerin, 2012)  el mapa de ecorregiones de (Ibisch & merida, 2003), la distribucion 

potencial de Aralia soratensis se encuentra con una alta probabilidad en bosques secos 

interandinos , con media y baja probabilidad en bosque tucumano boliviano, Chaco serrano, 

Yungas y Cerrado Chiquitano. La variable con mayor contribución al modelo es; elevación (51%), 

porcentaje de suelo desnudo (26,6%), precipitación del trimestre más húmedo (11%), temperatura 

máxima del mes más cálido (6%) y estacionalidad de la precipitación (5,3%). Aralia soratensis, 

tiene condiciones favorables para su desarrollo en bosques secos interandinos, como lo señalan 

(Pennington et al.,2004) y (Saravia,1993). 

Según (Muñoz, 2018) elaboro un modelo predictivo de distribución potencial del cultivo 

Chenopodium quinoa willd, en este estudio se lograron recopilar 1.256 registros de datos de 

presencia, bien distribuidos por el área de estudio. Maxent ofrece una serie de imágenes faciles de 

interpretar, que usan los colores para indicar si las condiciones son o no adecuadas para la especie 

estudiada. Los colores más cálidos muestran áreas con alta probabilidad de condiciones adecuadas 

para la especie, verde indica las condiciones típicas de aquellos lugares en los que se encuentra y 

sombras mas tenues de azul indican baja probabilidad de condiciones adecuadas. La variable 

ambiental con mayor ganancia cuando se usa de forma aislada es BIO8, que por lo tanto parece 

tener la informacion mas util en si misma, la variable ambiental que disminuye mas la ganancia 
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cuando se omite es el suelo, que por lo tanto tiene la mayor cantidad de información que no esta 

presente en las otras variables. Y  la variable que predice mejor por si sola  la distribucion es BIO5, 

ya que según la FAO y la Universidad Nacional Agraria la Molina (2016), las temperaturas optimas 

de crecimiento y desarrollo de quinoa se situan entre los 15 y 25 °C. 

Según (Mejía et al., 2014), reconoce como indicadora del bosque estacionalmente seco del 

Huallaga a diferentes especies de la flora particularmente de la familia Arecaceae ( Shica shica, 

Huicungo, Yarina, Inchaui) y entre ellas se encuentra Shapaja (Attalea moorei). 

Caracterización del suelo en las dos parcelas del Bosque estacionalmente seco del Huallaga 

Las localidades de Attalea moorei de San Pedro de Cumbaza y Pucacaca presentan diferencias 

en textura, pH, color y componentes principales que lo acompañan. Para San Pedro de Cumbaza 

los suelos presentan drenaje donde la textura es arcillosa con pH 7,34 que es ligeramente alcalino. 

El perfil del suelo presenta una capa superficial, la capa A mide 40 cm de profundidad donde el 

color del matiz es 2.5Y 8/6 Yelow.  Pucacaca está compuesto por suelos con deficiente drenaje, 

esto ocasiona que cada temporada de lluvia llegue a inundarse, de textura franco-arenosa con pH 

7.51 también ligeramente alcalino. El perfil del suelo está caracterizado por presentar una capa 

superficial. La Capa B mide 20 cm de profundidad donde el color del matiz es 10YR 4/2 marrón 

grisáceo. Estas diferencias encontradas serian uno de los factores que influyen en el crecimiento 

de categoría de Attalea moorei y la estructura del bosque estudiado en las dos localidades. 

(Macedo, 2015) realizo también las características de los suelos en los dos lugares de estudio 

Jenaro Herrera y Bagazán. Presentando diferencias en el sustrato y nivel de profundidad, 

principalmente esto sucede por la duración de los periodos de inundación y la napa freática que 

está cerca de la superficie. La zona de Jenaro Herrera presento suelos franco-limoso hasta una 

profundidad de 70 cm. Mientras que en Bagazán se observa la misma textura franco-limosa pero 

solo hasta los 30 cm, ya que a esta profundidad ya se encuentra la capa freática. Asimismo nos 

indica que el factor edafico influye en la diferenciación de la estructura del bosque e incluso 

también estaría relacionado con las diferencias morfológica. 

Según (FAO, 1972), señala que la provincia de San Martin presenta suelos acidos y de baja 

fertilidad, muy a menudo mal drenados. En la zona del huallaga se encuentran derivados de 

sedimentos recientes a base de arenas y limo, son suelos profundos  bien drenados, pardo rojizo 

oscuro a pardo 1.01;20 y de textura media. Presentan perfiles de escaso grado de desarrollo y con 

predominancia de colcareo libre en la masa. Para la provincia de Picota los suelos estan derivados 
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sobre materiales fluviales finos, profundos, moderadamente drenados, arcillosos plásticos y de 

matices predominantemente pardo rojizo oscuro, franco arenoso, pardo a pardo oscuro ( 7.5 YR 

4.4) masivo, suave en seco, ligeramente alcalino pH 7.7. Para San Martin (Tarapoto) presentaron  

suelos profundos, bien drenados, con un B Podsálico de textura fina, rojizo amarillento a pardo 

fuerte, con películas de arcilla (cloys skins), friable y débilmente estructurado, con caracteristica 

arcillo arenoso, pardo fuerte en húmedo (7.5YR 5/8), en bloques angulares medios débiles, 

ligeramente duro en seco, muy fuertemente acido (pH 4.5), contenido muy bajo de materia 

orgánica, permeabilidad moderada, muy pocas raices. 

El presente estudio de Attalea moorei en San Pedro de Cumbaza y Pucacaca presentan 

diferencias significativas ya que el valor p se encuentra debajo de nuestro nivel de significancia 

(α=0,05),con lo cual rechazamos la H0 y aceptamos la H1 concluyendo  que hay si existe diferencia 

significativa entre la estructura poblacional de Attalea moorei y las dos parcelas del Bosque 

estacionalmente seco del Huallaga, San Martin 
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CAPITULO V 

CONCLUSIONES Y RECOMENDACIONES 

5.1 Conclusiones 

 La estructura poblacional de Attalea moorei entre San Pedro de Cumbaza y 

Pucacaca presentan diferencia significativa. 

 Se encontraron más individuos de la categoría I ( plántulas) en ambas poblaciones, 

eso significa que el estado de las poblaciones naturales de Attalea moorei en San Pedro 

de Cumbaza y Pucacaca son favorables para la regeneración y la viabilidad de la 

población. 

 La especie Attalea moorei  confirma que es característica de las dos zonas de 

estudio y es un indicador del tipo de bosque estacionalmente seco del Huallaga. 

 Se concluye que a partir del modelo de predicción se obtuvo el mapa de presencia 

y distribución de la especie. 

  Los perfiles de suelo mostrados son característicos de la zona del Huallaga central. 

 5.2 Recomendaciones   

 Para el estudio de la estructura poblacional de Attalea moorei es necesario 

relacionarla con la caracterización morfológica de la población ya que nos permitirá 

tener la mayor información de productividad de la especie. 

 Abarcar más puntos de distribución de Attalea moorei en toda la región San Martin 

asimismo agregar más variables ambientales ya que esto nos ayudará a observar en que 

lugares o provincias se encuentra la mayor distribución de la especie. 

 Para la caracterización del suelo se recomienda realizar análisis químicos con la 

finalidad de conocer los requerimientos nutricionales para el desarrollo de las 

poblaciones de Attalea moorei. 

 Seguir con las investigaciones sobre Attalea moorei en los diferentes lugares que 

se encuentra distribuida ya que esto nos permitirá profundizar el conocimiento, 

desarrollo, distribución y fenología  de la especie. 

 Realizar mayores estudios nos permitirá aprovechar de manera sostenible a la 

especie, ya que tiene un amplio potencial a nivel ambiental, industrial entre otros.  
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ANEXOS 

Anexo 1.  Formato de evaluación en campo para estructura poblacional de Attalea moorei 

 

Leyenda: Formato usado para evaluar la estructura poblacional de San Pedro de Cumbaza 

y Pucacaca 
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 Anexo 2. Delimitación y establecimiento de Sub-parcelas en San Pedro de Cumbaza y 

Pucacacaatta 

 

Anexo 3. Evaluación de la estructura poblacional en San Pedro de Cumbaza y Pucacaca 

 

 

 

 

 

 

 

 

 

 Leyenda: a-b. Medición de alturas de Attalea moorei.  c-d. Registro y toma de datos de 

estructura poblacional en cada subparcela instalada. 

  

a b 

d c 

Leyenda: a-b. Delimitación e instalación de parcela en San Pedro de Cumbaza.  c-d.     

Delimitación e instalación de parcela en Pucacaca (ABOFOA).   

a 

c d 

b 
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Anexo 4.  Individuos por categorías de crecimiento de Attalea moorei en San Pedro de 

Cumbaza y Pucacaca  

 

 

 

 

 

 

 

CATEGORÍA I: Regeneración 

Natural  

Leyenda: a-b-c-d. Individuos de Categoría I (Regeneración natural)   

  

c d 

a b 
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CATEGORÍA II: Juvenil 

acaule  

CATEGORÍA III: Sub-Adulto inmaduro, 

caulescente 

Leyenda: a-b. Individuos de Categoría II (Juvenil acaule)   

  

Leyenda: a-b. Individuos de Categoría III (Sub-Adulto inmaduro, caulescente)   

  

a b 

a b 
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 Anexo 5. Colecta y caracterización morfología de Attalea moorei en San Pedro de Cumbaza 

y Pucacaca. 

 

 

 

 

 

 

 

 

 

 

CATEGORÍA IV: Adulto 

reproductor  

Leyenda: a-b. Individuos de Categoría IV(Adulto reproductor)   

  

Leyenda: a. Selección del individuo a caracterizar. b. Medición de altura , diámetro del tallo y 

corte de una hoja del individuo. c. Conteo de pinnas (foliolos) de la hoja. d. Medición hoja completa. 

e. Medición de la pinna distal, media y proximal. f. Se corta la hoja en tres partes base, media y apical, 

procediendo a colocar su respectivo codigo de colecta para secar y herborizar la muestra. 

)  

a b 

a 

d f e 

b c 



98 

 

Anexo 6. Fases de Germinación, bráctea e inflorescencia de Attalea moorei  

 

Anexo 7.- Infrutescencia de de Attalea moorei 

 

 

 

 

 

 

 Anexo 7.  Infrutescencia de Attalea moorei 

 

 

 

 

 

 

 

 

 

 

 

 

 

Leyenda: a. Fase de germinación, plántulas extraídas incluyendo raíz y semillas. b. Bráctea 

y Inflorescencia estaminada unilaterales en raquillas estaminadas. 

 

  

Leyenda: a. Infrutescencia. b. Raquillas mostrando cicatrices de los frutos caídos. 

  

a b 

a b 
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Anexo 8. Registro de puntos de distribución de Attalea moorei en la región San Martin 

 

 

 

 

 

 

 

 

 

Anexo 9. Calicatas y toma de muestra para caracterización de suelo en San Pedro de Cumbaza 

y Pucacaca 

  

Leyenda: a-b. Toma y registro de coordenadas geograficas de distribucion  de Attalea 

moorei ( Shapaja) en la region San Martin. 

 

 

 

 

 

 

 

 

  

Leyenda: a-b. Calicata de 1m de largo por 1m ancho 70 cm de profundidad, toma de muestra de 

suelo para caracterización y comparación con la tabla munsell en San Pedro de Cumbaza. c-d. Calicata 

de 1m de largo por 1m ancho 70 cm de profundidad, toma de muestra de suelo para caracterización y 

comparación con la tabla munsell en Pucacaca. 

 

 

a b 

a 

d c 

b 


